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Epson Stylus CX4900 Series All-in-One 
User’s Guide

This User’s Guide contains instructions on printing and scanning with Windows® or 
Macintosh,® copying photos to and from a memory card or camera, maintaining your 
Epson Stylus CX4900 Series all-in-one, solving basic problems, and specifications. To 
set up your CX4900 Series and install your software, see the Start Here sheet.

Please follow these guidelines throughout:

Warnings must be followed carefully to avoid bodily injury.

Cautions must be observed to avoid damage to your equipment.

Notes contain important information about your CX4900 Series.

Tips contain additional hints for better copying, printing, and scanning.

About Your CX4900 Series

Your CX4900 Series is great for all your everyday projects and photos. It provides you 
with these advanced features:

■ Epson’s revolutionary DURABrite® Ultra pigment inks. These quick-drying inks 
are resistant to water, fading, and smudging on plain and photo paper so your 
prints stand the test of time. 

Note: 

The light resistance of prints is rated up to 100 years on specialty papers and 70 
years on plain paper. The light resistance rating is based on accelerated testing of 
prints on Epson® special media, displayed indoors, under glass. Actual print 
stability will vary according to media, printed image, display conditions, light 
intensity, humidity, and other atmospheric conditions. Epson does not guarantee 
the longevity of prints. For maximum print life, display all prints under glass or 
lamination or properly store them.

■ True BorderFree® frame-ready prints on select 4 × 6, 5 × 7, 8 × 10, and letter-size 
papers. 

■ Built-in Epson Easy Photo FixTM technology to quickly restore faded color photos 
while you scan so they look as good as new.
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About Exif Print

The Exif (Exchangeable Image File) Print format includes information about your 
digital camera settings in JPEG files so your printer and application can use them to 
create accurate print settings. Most digital cameras store Exif Print information such 
as shutter speed, metering, flash, and exposure settings, resolution, and lens use in the 
JPEG image file. Your printer—along with ArcSoft PhotoImpressionTM—uses the 
information to ensure the most accurate image reproduction.

About Your Software

The CD-ROM that came with your CX4900 Series includes all the software you need 
for printing and scanning. See your Start Here sheet for installation instructions.

■ Your printer driver lets you control how your documents look. You can’t print 
from your computer without it.

■ Your scanner software lets you scan from your computer and control how your 
scans look. You can’t scan without it.

Tip: 

It’s a good idea to check Epson’s support website, www.latin.epson.com, 
periodically for free updates to your CX4900 Series printing and scanning 
software. Download instructions are posted for your convenience. You can also 
click the Driver Update button on the Maintenance tab in your Windows printer 
driver screen for printer driver updates. Click the Driver Update shortcut in the 
Epson Scan menu in the Programs folder for scanner driver updates.

■ ArcSoft PhotoImpression lets you edit, retouch, or enhance images and print 
them with templates, frames, and borders. It supports Exif Print. See the 
PhotoImpression Help utility for instructions on using the program.

■ ABBYY FineReader® Sprint lets you scan a document and convert the text into 
data that you can edit with a word processing program.
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■ Epson PhotoCenterSM is Epson’s free photo-sharing website where you can store, 
organize, and share your photos; print high-resolution photos straight from the 
web; and create free online postcards with your photos. Your printer software 
installer lets you add a link to the Epson PhotoCenter on your desktop.

■ Epson CreativeZoneSM is Epson’s free photo project website where you can 
combine your favorite photos, Epson papers, and your printer to create 
unforgettable personalized craft projects. Your printer software installer lets you 
add a link to the Epson CreativeZone on your desktop.

■ Epson Web-To-PageTM automatically adjusts web pages to fit your printed page. 
No more cut-off edges! All you have to do is select Print on the Web-To-Page 
toolbar in Internet Explorer (requires Windows 98SE, Me, 2000, XP, or XP 
Professional x64 Edition with Internet Explorer 5.5 or later).
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Printing From Your Computer

Before you start, make sure the Epson Stylus CX4900 Series all-in-one is set up, its 
software is installed, and it is connected to your computer as described on the Start 
Here sheet.

Also make sure you have loaded paper as described in Loading Paper. 

To print, follow the instructions in these sections for your computer:

Printing in Windows

Printing with Macintosh OS X

Whenever you print, make sure you tell the CX4900 Series what kind of paper you’re 
using. See Selecting the Correct Paper Type for details.

For details on printing borderless photos, see Printing Borderless Photos.

Loading Paper

■ Single Sheets

■ Envelopes

■ Special Papers

Single Sheets

1. Open the paper support and slide out the extensions.



7

2. Open the output tray and pull out the extension.

3. Flip the feeder guard forward.
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4. Insert the paper, printable side up, against the right edge guide. Always load it 
short edge first, even for landscape printing. Make sure the paper lies beneath the 
tabs and the arrow mark on the left edge guide.

You can load up to 100 sheets of plain paper and up to 20 sheets of photo paper. 
(See Special Papers for capacity guidelines on other paper types.)

Note: 

The type of paper you choose affects the way your printout looks, so be sure to 
select the correct paper for your job. If you are just making a copy or printing a 
rough draft of an image, plain paper is fine. However, for the best results, you’ll 
want to use one of Epson’s special ink jet papers designed for your printer. For 
example, your photos will look great printed on Epson Ultra Premium Photo Paper 
Glossy. See Special Papers for more information.

Letter-size 
paper

4 × 6 inch 
(10,2 × 15,2 cm) 
or 5 × 7 inch 
(12,7 × 17,8 cm), 
or other paper 
sizes
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5. Slide the left edge guide against the left edge of the paper (but not too tightly).

6. Flip the feeder guard back.

Follow these guidelines when loading paper:

■ Don’t load paper above the arrow on the left edge guide. Make sure the paper is 
under the tabs on the left and right edge guides.

■ Load the printable side face-up. It’s often brighter or whiter than the other side.

■ Always load the short edge first, even when printing in landscape mode.

■ Load letterhead or preprinted paper into the printer top edge first.

■ If you experience paper feeding problems, try loading fewer sheets.

■ If you’re using special paper, check the package for special loading instructions.
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Envelopes

1. Open the paper support and slide out the extensions.

2. Open the output tray and pull out the extension.

3. Set the paper thickness lever to the H position.

Thickness 
lever
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4. Load up to 10 envelopes at a time, flap edge left, printable side up, against the 
right edge guide.

Note: 

For best results, press each envelope flat before loading, or load one envelope at 
a time.

5. Slide the left edge guide against the envelopes (but not too tightly).

6. Flip the feeder guard back.

Select the following settings when printing on envelopes:

■ Envelope as the paper Type or Media Type setting

■ The correct envelope size as the Size or Paper Size setting

■ Landscape as the Orientation setting

For instructions on selecting these settings, see:

■ Printing in Windows

■ Printing with Macintosh OS X

Load the flap edge 
left, printable side up
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Special Papers

Epson offers the following special papers for the CX4900 Series:

Paper name* Size Part number

Epson Ultra Premium Photo Paper Glossy
Epson Ultra Premium Glossy Photo Paper

Borderless 4 × 6 inches 
(10,2 × 15,2 cm)

S041934

Letter (8,5 × 11 inches; 
21,6 × 27,9 cm)

S041935

Epson Bright White Paper Letter (8,5 ×11 inches; 
21,6 × 27,9 cm)

S041586

Epson Premium Photo Paper Glossy
Epson Premium Glossy Photo Paper

Borderless 4 × 6 inches 
(10,2 × 15,2 cm)

S041808 
S041727

Borderless 5 × 7 inches 
(12,7 × 17,8 cm)

S041464

Borderless 8 × 10 inches 
(20,3 × 25,4 cm)

S041465

Letter (8,5 ×11 inches; 
21,6 × 27,9 cm)

S041286 
S041667

Epson Premium Photo Paper Semi-gloss
Epson Premium Semigloss Photo Paper

Letter (8,5 ×11 inches; 
21,6 × 27,9 cm)

S041331

Epson Photo Paper Glossy
Epson Glossy Photo Paper 

4 × 6 inches 
(10,2 × 15,2 cm)

S041134 
S041671 
S041809
S041809-20

Letter (8,5 × 11 inches; 
21,6 × 27,9 cm)

S041141 
S041649 

A4 (21,1 × 29,7 cm; 8,3 
× 11,7 inches)

S041140

Epson Premium Presentation Paper Matte
Epson Matte Paper Heavyweight

Letter (8,5 × 11 inches; 
21,6 × 27,9 cm)

S041257

Borderless 8 × 10 inches 
(20,3 × 25,4 cm)

S041467
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* The availability of paper types and sizes varies by location.

You can purchase genuine Epson ink and paper from an authorized Epson reseller. To 
find the nearest reseller, please call your nearest Epson sales office.

When loading Epson ink jet papers, follow the capacity guidelines below. See 
Selecting the Correct Paper Type for the paper type settings you should select for 
these papers in the printer software.

Epson Premium Presentation Paper Matte
Double-Sided
Epson Double-Sided Matte Paper

Letter (8,5 × 11 inches; 
21,6 × 27,9 cm)

S041568

Epson Presentation Paper Matte
Epson Photo Quality Ink Jet Paper

Letter (8,5 × 11 inches; 
21,6 × 27,9 cm)

S041062

Legal (8,5 × 14 inches; 
21,6 × 35,6 cm)

S041067

Epson High Quality Ink Jet Paper Letter (8,5 × 11 inches; 
21,6 × 27,9 cm)

S041111

A4 (21,1 × 29,7 cm; 8,3 
× 11,7 inches)

S041117

Paper type Loading capacity

Epson Premium Bright White Paper 80 sheets

Epson Ultra Premium Photo Paper Glossy
Epson Ultra Premium Glossy Photo Paper

Epson Premium Photo Paper Glossy
Epson Premium Glossy Photo Paper

Epson Premium Photo Paper Semi-gloss
Epson Premium Semigloss Photo Paper

Epson Photo Paper Glossy
Epson Glossy Photo Paper

Epson Premium Presentation Paper Matte
Epson Matte Paper Heavyweight

Epson Premium Presentation Paper Matte Double-Sided
Epson Double-Sided Matte Paper

20 sheets

Paper name* Size Part number
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Printing in Windows

See these sections for instructions on printing from a computer running Windows:

■ Printing Using Windows XP Picture and Fax Viewer

■ Printing from an Application

■ Selecting the Default Settings for All Windows Programs

■ Customizing Windows Print Settings

Printing Using Windows XP Picture and Fax Viewer

1. Locate the photo you want to print on your computer. 

2. Right-click the photo, highlight Open With, and select Windows Picture and 
Fax Viewer. 

Epson Presentation Paper Matte
Epson Photo Quality Ink Jet Paper

Epson High Quality Ink Jet Paper

100 sheets

Paper type Loading capacity

Print icon
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3. Click the  Print icon at the bottom of the screen. 

4. Click Next. You see a Picture Selection window (if there are other photos in your 
folder):
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5. Select the photo(s) you want to print and click Next. You see the Printing 
Options window:

Select your EPSON 
Stylus CX4900 Series

Printing 
Preferences
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6. Select EPSON Stylus CX4900 Series and click Printing Preferences. You see 
the printer settings window:

7. Select from these Quality Option types:

■ Draft: For rough drafts with reduced print quality

■ Text: For text-only documents with higher text quality

■ Text & Image: For documents with text and images with higher quality

■ Photo: For photos and graphics with good quality and speed

■ Best Photo: For photos or graphics with high print quality
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Note: 

For more information about print settings, click the ? or Help button.

The Quality Option settings on this screen give you the best combination of 
quality and speed for most prints. For the highest quality (Photo RPM) on 
selected papers, click the Advanced button on the Main tab. Then see 
Customizing Windows Print Settings for instructions.

8. Make sure the paper Type and Size settings match the paper you’ve loaded in the 
printer. 

9. Select your document or image orientation.

10. Click OK.

11. At the Photo Printing Wizard screen, click Next. You see a Layout Selection 
window:

12. Select Full page photo print and click Next.

Full page photo print
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During printing, the following window appears to show the progress of your print 
job. You can use the buttons to cancel, pause, or resume printing. You can also see the 
approximate ink levels.

Click to cancel 
printing

Click to pause or 
resume printing
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Printing from an Application

After you create a document in a software program, follow these steps to print it using 
the basic printer settings:

1. Open the File menu and select Print. You see a window like this one:

2. Make sure EPSON Stylus CX4900 Series is selected.

3. Click the Properties or Preferences button. (If you see a Setup, Printer, or 
Options button, click it. Then click Properties or Preferences on the next 
screen.)

Open your printer 
software

Select your EPSON Stylus CX4900 Series
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You see the basic printer settings window:

4. Select from these Quality Option types:

■ Draft: For rough drafts with reduced print quality

■ Text: For text-only documents with higher text quality

■ Text & Image: For documents with text and images with higher quality

■ Photo: For photos and graphics with good quality and speed

■ Best Photo: For photos or graphics with high print quality

Note: 

For more information about print settings, click the ? or Help button.

The Quality Option settings on this screen give you the best combination of 
quality and speed for most prints. For the highest quality (Photo RPM) on 
selected papers, click the Advanced button on the Main tab. Then see 
Customizing Windows Print Settings for instructions.

Select the type of document you’re printing

Select your 
paper Type

Select your 
paper Size

Select your 
document or 
image orientation
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5. Make sure the paper Type and Size settings match the paper you’ve loaded in the 
printer. 

6. Select your document or image orientation.

7. Click OK.

8. At the Print window, click OK or Print to start printing.

During printing, the following window appears to show the progress of your print 
job. You can use the buttons to cancel, pause, or resume printing. You can also see the 
approximate ink levels.

Selecting the Default Settings for All Windows Programs

When you change the printer settings within a program, they apply only to that 
program. If you want to change the default printer settings for all your programs, 
follow these steps:

1. Right-click the printer icon in the lower right corner of your screen (taskbar).

2. Select Printer Settings. You see the printer settings window.

Click to cancel 
printing

Click to pause or 
resume printing



23

3. Select the default settings you want for all your applications, then click OK.

You can still change the printer settings in your individual programs, when necessary. 
They will override the Windows default settings until the next time you turn on or 
reset your computer.

Customizing Windows Print Settings

You can use advanced settings for color matching, printing at a higher resolution, or 
selecting a variety of special effects and layouts.

1. On the Main tab, click the Advanced button in the bottom right corner of the 
window.

2. If you see a warning note, click Continue.

3. Select the following advanced settings as necessary:

Select a color 
management 
method

(To choose 
No Color 
Adjustment, 
click ICM 
first)

Select Paper & Quality 
Options as necessary

Click here to select 
Photo RPM for the 
best print quality on 
certain paper types

Select Print Options 
as necessary
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Note: 

When you select Photo RPM for the highest print quality, printing will take 
longer. 

For more information about advanced settings, or instructions on saving them as 
a group so you can reuse them later, click the ? or Help button. If you want to use 
the Advanced screen each time you access your printer settings, click Show this 
screen first.

4. Once you’ve finished selecting advanced settings, you can:

■ Click OK to save your settings, return to the Print window, and print.

■ Click the Basic button to return to the basic settings.

■ Continue with step 5 to change the layout options.

5. Click the Page Layout tab and select the following page layout settings as 
necessary:

Note: 

For more information on page layout settings, click the ? or Help button.

6. Click OK to save your settings, then click OK or Print.

Select multi-page 
document options 
here and here

Select image resizing 
options here; these 
affect only your 
printed image

Select image 
position options 

Add a watermark to 
printed page
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Printing with Macintosh OS X

See these sections for instructions on printing from a Macintosh running Mac OS X:

■ Printing from an OS X Application

■ Customizing Mac OS X Print Settings

Printing from an OS X Application

1. Open the File menu and select Page Setup. You see the Page Setup window:

2. Select Stylus CX4900 in the Format for pop-up menu.

3. Select your Paper Size. For borderless printing, select a paper size with the Sheet 
Feeder - Borderless option. See Printing Borderless Photos for details.

4. Select  portrait or  landscape as the orientation setting.

5. Click OK.

Select your Stylus CX4900

Select your Paper Size

Select your document 
or image orientation
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6. Open the File menu and select Print. You see a window like this one:

7. Select Stylus CX4900 in the Printer pop-up menu.

8. Select Print Settings from the pop-up menu.

9. Select the following Print Settings as necessary:

Select Print Settings

Select your 
Stylus CX4900

Select your Media 
Type

Select Color or 
Black Ink

Select higher 
quality or faster 
printing (if available)

Click Print
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Note: 

For more information about printer settings, click the ? button.

10. Depending on your settings, you can choose other options from the pop-up 
menu:

■ Copies & Pages: Select the number of copies you want or a page range.

■ Layout: Select page layout options.

■ Scheduler: Schedule your print job to print at a later time.

■ Paper Handling: Select page printing options, such as Reverse print order.

■ ColorSync® or Color Management: Select ColorSync or adjust the color 
controls, change the gamma setting, or turn off color adjustments in the 
printer software.

■ Cover Page (OS X 10.4.x only): Print a cover page before or after your 
document.

■ Expansion: Reduce or enlarge the image size for borderless printing. See 
Printing Borderless Photos for details.

■ Summary: View a list of all your selections.

11. To save your selections for future use, select Save As from the Presets pop-up 
menu.

12. Click Print.

13. To monitor the progress of your print job, click the  printer icon when it 
appears in the dock on the bottom of your desktop. 

If you’re using OS X 10.2.x, click the  Print Center icon instead, then 
double-click Stylus CX4900 in the Printer List window.
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You see a screen like this:

If necessary, you can do one of the following while monitoring the progress of 
your print job:

■ Click the print job, then click Delete to delete it

■ Click the print job, then click Hold to pause printing

■ Click a print job marked “Hold” and click Resume to resume printing

14. When you’re finished, close the printer window or Print Center.
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Customizing Mac OS X Print Settings

You can use advanced settings for color matching or printing at a higher resolution.

1. On the print settings window, click Advanced and choose these settings as 
necessary:

Note: 

When you select Photo RPM for the highest print quality, printing will take 
longer.

For more information on advanced settings, or instructions on saving them as a 
group so you can reuse them later, click the ? button.

2. Click Print.

Selecting the Correct Paper Type

Your CX4900 Series automatically adjusts itself for the type of paper you select in 
your print settings. That’s why the paper Type or Media Type setting is so important. 
It tells your printer what kind of paper you’re using and adjusts the ink coverage 
accordingly.

For color management 
settings, select Color 
Management from the 
pop-up menu

Select Photo RPM for 
the best print quality on 
certain paper types
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The table below lists the settings you should choose for your paper:

Printing Borderless Photos

You can print your photos with no margins, extending the image all the way to the 
edges of the page. Although borderless printing is a bit slower, you get beautiful 
snapshots and enlargements, without trimming. 

See Loading Paper for Borderless Photos, then see these sections for instructions on 
printing borderless photos:

■ Windows

■ Macintosh OS X

For this paper . . .

Select this Type or Media 

Type setting . . .

Plain paper
Epson Bright White Paper

Plain Paper / 
Bright White Paper

Epson Ultra Premium Photo Paper Glossy
Epson Ultra Premium Glossy Photo Paper

Ultra Premium Photo Paper 
Glossy

Epson Premium Photo Paper Glossy
Epson Premium Glossy Photo Paper

Premium Photo Paper 
Glossy

Epson Photo Paper Glossy
Epson Glossy Photo Paper

Photo Paper Glossy

Epson Premium Photo Paper Semi-gloss
Epson Premium Semigloss Photo Paper

Premium Photo Paper 
Semi-Gloss

Epson Premium Presentation Paper Matte
Epson Matte Paper Heavyweight

Epson Premium Presentation Paper Matte Double-Sided
Epson Double-Sided Matte Paper

Epson Presentation Paper Matte
Epson Photo Quality Ink Jet Paper

Epson High Quality Ink Jet Paper

Premium Presentation 
Paper Matte

Envelopes Envelope
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Loading Paper for Borderless Photos

You can print borderless photos on these papers and sizes:

Load your paper as shown in Loading Paper.

With proper care, photographs from your CX4900 Series will last for many years. The 
special Epson DURABrite Ultra inks designed for your CX4900 Series are formulated 
to achieve improved lightfastness when used with Epson papers for prints that are 
properly displayed or stored. For best results, always use Epson papers.

As with traditional photos, Epson recommends proper care that will minimize color 
changes and lengthen display life: 

Paper name Sizes

Paper Type or 

Media Type 

setting

Epson Ultra Premium Photo 
Paper Glossy
Epson Ultra Premium Glossy 
Photo Paper

4 × 6 inches (10,2 × 15,2 
cm)
Letter (8,5 × 11 inches; 21,6 
× 27,9 cm)

Ultra Premium 
Photo Paper Glossy

Epson Premium Photo Paper 
Glossy
Epson Premium Glossy Photo 
Paper

4 × 6 inches (10,2 × 15,2 
cm)
5 × 7 inches (12,7 × 17,8 
cm)
Letter (8,5 × 11 inches; 21,6 
× 27,9 cm)

Premium Photo 
Paper Glossy

Epson Photo Paper Glossy
Epson Glossy Photo Paper

4 × 6 inches (10,2 × 15,2 
cm)
Letter (8,5 × 11 inches; 21,6 
× 27,9 cm)

Photo Paper Glossy

Epson Premium Photo Paper 
Semi-gloss
Epson Premium Semigloss 
Photo Paper

Letter (8,5 × 11 inches; 21,6 
× 27,9 cm)

Premium Photo 
Paper Semi-Gloss

Epson Premium Presentation 
Paper Matte
Epson Matte Paper Heavyweight

8 × 10 inches (20,3 × 25,4 
cm)
Letter (8,5 × 11 inches; 21,6 
× 27,9 cm)

Premium 
Presentation Paper 
Matte
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■ Frame prints under glass or a protective plastic sleeve to protect them from 
atmospheric contaminants like humidity, smoke, and high levels of ozone.

■ As with all photographs, keep your prints away from direct sunlight.

■ For proper storage, keep your prints in a photo album or plastic photo storage box 
in acid-free, archival sleeves commonly available from most camera stores.

■ Always keep unused paper in the original package. 

You can purchase genuine Epson ink and paper from an authorized Epson reseller. To 
find the nearest reseller, please call your nearest Epson sales office.

Windows

1. Open the File menu and select Print. 

2. Click the Properties or Preferences button. (If you see a Setup, Printer, or 
Options button, click it. Then click Properties or Preferences on the next 
screen.)

You see a window like this one:

3. Select Photo or Best Photo as the Quality Option setting.

Click the Borderless 
checkbox
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4. Select one of the following for the paper Type option, to match the paper you’re 
using:

■ Ultra Premium Photo Paper Glossy

■ Premium Photo Paper Glossy

■ Photo Paper Glossy

■ Premium Photo Paper Semi-Gloss

■ Premium Presentation Paper Matte

5. Click the Borderless checkbox. Read the message and click OK.

6. Select your paper Size setting. See the list of supported borderless sizes in Printing 
Borderless Photos.

7. Select Portrait or Landscape as the orientation setting.

8. Click the Page Layout tab. You see a window like this one:

9. If necessary, adjust the Expansion slider in the Borderless box to choose Min, 
Max, or the in-between setting. 

Expansion 
slider
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Min retains most image area in your print, but there may be a small white edge on 
the borders of the print. Max expands the image to ensure that there are no 
unprinted edges, but the edges of the image may not appear in the print. 

10. Click OK.

11. At the Print window, click OK or Print.

Macintosh OS X

1. Open the File menu and select Page Setup. You see a window like this one:

2. Select Stylus CX4900 in the Format for pop-up menu.

3. Select one of the following settings as your Paper Size:

■ 4 × 6 (Sheet Feeder - Borderless)

■ 5 × 7 (Sheet Feeder - Borderless)

■ 8 × 10 (Sheet Feeder - Borderless)

■ US Letter (Sheet Feeder - Borderless)

4. Select  portrait or  landscape as the orientation setting.

5. Click OK.

6. Open the File menu and select Print.

7. Select Stylus CX4900 in the Printer pop-up menu.

8. Select Print Settings from the pop-up menu. 



35

Note: 

In certain programs, you may need to select Advanced before you can select 
Print Settings.

9. Select one of the following for the Media Type option, to match the paper you’re 
using:

■ Premium Photo Paper Glossy

■ Premium Photo Paper Semi-Gloss

■ Ultra Premium Photo Paper Glossy

■ Premium Presentation Paper Matte

■ Photo Paper Glossy

10. Select Quality (for higher quality) or Speed (for faster printing) using the slider.
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11. Select Expansion from the pop-up menu. You see a window like this one:

12. If necessary, adjust the Expansion slider to choose Min, Max, or the in-between 
setting. 

Min retains the most image area in your print, but there may be a small white 
edge on the borders of the print. Max expands the image to ensure that there are 
no unprinted edges, but the edges of the image may not appear in the print. 

13. Click Print.
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Scanning

Follow the steps in these sections to scan documents or photos to your computer:

Placing Originals for Scanning

Starting Epson Scan

Selecting Epson Scan Settings

Restoring Color in Photos

Scanning Directly to a PDF File

Placing Originals for Scanning

Caution: 

Do not place heavy objects on the document table glass and do not press the 
glass with too much force.

1. Open the document cover and place your original face-down on the glass, in the 
upper left corner.
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2. Close the document cover gently so that your original does not move.

Caution: 

Never open the document cover beyond where it stops and do not place heavy 
objects on top of the Epson Stylus CX4900 Series all-in-one.

Note: 

If you are scanning a large or thick document, you can remove the document 
cover. See Placing Large or Thick Documents for instructions.

To scan your document or photo, see Starting Epson Scan.
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Placing Large or Thick Documents

When you scan a large or thick document, you can remove the document cover. Just 
open it and pull it straight up.

If you need to press the document flat while you copy or scan it, do not press too hard 
and be careful not to move it.

Caution: 

Do not use excessive force on the document cover, and do not twist it diagonally. 
You may damage the document cover.

When you are done, replace the document cover by inserting the tabs back into the 
slots.

Starting Epson Scan

If you want to scan an image and save it directly to a file, you can use the Epson Scan 
program.
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You can also use any TWAIN-compliant scanning program, such as ArcSoft 
PhotoImpression, to scan with Epson Scan. When you are finished, the scanned 
image opens in your scanning program so you can modify, print, and save it.

Epson Scan offers three scanning modes. See Overview of the Epson Scan Modes for a 
description.

Then follow the steps in one of these sections to start Epson Scan:

■ Starting Epson Scan as a Standalone Program

■ Starting Epson Scan With Another Scanning Program

Overview of the Epson Scan Modes

Epson Scan lets you control all aspects of scanning and includes three modes:

■ Full Auto Mode lets you scan quickly and easily, without selecting any settings or 
previewing your image. This is the default mode in Epson Scan.

Full Auto Mode is best when you need to scan documents or photos at 100% size 
and you do not need to preview the images before scanning. You can restore faded 
colors by clicking the Customize button. 

■ Home Mode lets you customize some scanning settings and check their effects 
with a preview image.

Home Mode is best when you want to preview images of photos before scanning 
them. You can size the image as you scan, adjust the scan area, and adjust many 
image settings, including color restoration. 

■ Professional Mode gives you total control of your scanning settings and lets you 
check their effects with a preview image.

Professional Mode is best when you want to preview your image and make 
extensive, detailed corrections to it before scanning. You can sharpen, color 
correct, and enhance your image with a full array of tools, including color 
restoration.

Starting Epson Scan as a Standalone Program

1. Do one of the following to start Epson Scan:
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Windows:
Double-click the EPSON Scan icon on your desktop.

Or select Start > All Programs or Programs > EPSON Scan > EPSON Scan.

Mac OS X:
Open the Applications folder and click the EPSON Scan icon.

The Epson Scan standby window appears:

2. If the Mode setting in the upper right corner of the window is set to Full Auto 
Mode, click the Scan button. (For instructions on selecting optional settings, see 
Using Full Auto Mode.)

Note: 

If you are in Home or Professional Mode, you see the Epson Scan settings 
window. For instructions on using Home or Professional Mode, see Selecting 
Basic Settings. To change scan modes, see Changing the Scan Mode.
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3. The File Save Settings window appears. For instructions on selecting options, see 
Selecting File Save Settings.

4. When you are finished selecting File Save Settings, click OK. Epson Scan starts 
scanning in Full Auto Mode. 

5. The scanned image is automatically saved in the specified location.

If the Open image folder after scanning checkbox is selected in the File Save 
Settings window, Windows Explorer or the Macintosh Finder automatically 
opens to the folder where the scanned image was saved.

For more information, see Using Full Auto Mode.

Starting Epson Scan With Another Scanning Program

1. Start your scanning program. 

Double-click the program icon from your desktop, if it is available, or do one of 
the following:

Windows:
Select Start > All Programs or Programs > program folder > program icon.
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Mac OS X:
Open the Applications folder, select the program folder, and click the 
program icon.

2. Select your program’s scanning option. (See your scanning program help for 
instructions.)

For example, in ArcSoft PhotoImpression, open the File menu and select Get 
Photo. Then click the Camera/Scanner icon.

Note: 

In some programs, you must select the CX4900 Series as the “source” first. If 
you see a Select Source option, choose it and select your CX4900 Series there 
first.

3. Select your CX4900 Series.

Note: 

With Windows XP, do not choose a WIA option for your CX4900 Series; it will not 
work correctly.

Epson Scan starts automatically. For instructions on using it, see Selecting Epson 
Scan Settings.

Selecting File Save Settings

When you see the File Save Settings window, you need to select the location, name, 
and format of the scanned image file you want to save.

1. In the File Save Settings window, specify the file folder in which you want to save 
your scanned image. Click the My Documents or My Pictures radio button 
(Windows), or the Documents or Pictures radio button (Macintosh).
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If you want to select another folder, click Other, then click Browse (Windows) 
or Choose (Macintosh) and select the folder. If you want to save your image on 
the desktop, simply click Other.

2. Specify a file name prefix with an alphanumeric character string. A 3-digit 
number is automatically added to the file name, but you can change the Start 
Number if you like. If you are scanning multiple images at once, each image will 
receive a different 3-digit number.

Note: 

With Windows, the following characters cannot be used in the prefix.
\, /, :, ., *, ?, ", <, >, |. On a Macintosh, you cannot use a colon (:) in the prefix.

3. Select a file format as described in the following table. Depending on the format, 
the Options button may be available for making detailed settings.

Format (File 

Extension) Explanation

BITMAP 
(*.BMP) 
(Windows 
only)

A standard image file format for Windows. Most Windows 
programs, including word processing programs, can read and 
prepare images in this format.
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4. The checkboxes at the bottom of the window give you these options:

■ Overwrite any files with the same name
Select this option if you want to reuse the selected file name and location and 
overwrite previous files with the same names.

JPEG (*.JPG) A compressed file format in which the compression level can 
be selected. The JPEG format lets you highly compress image 
data. However, the higher the compression, the lower the 
image quality. Any lost image quality data cannot be restored 
and the quality deteriorates each time the data is saved. The 
TIFF format is recommended when modification and retouching 
are required.

Multi-TIFF 
(*.TIF)

A TIFF format where multiple pages are saved to the same file. 
(With other formats, each document is saved in a separate file.) 
You can also edit the images before saving them. To open 
Multi-TIFF files, you need a program that supports it.

TIFF (*.TIF) A file format created for exchanging data between many 
programs, such as graphic and DTP software. When scanning 
black & white images, you can specify the compression type.

PDF (*.PDF) A document format that can be read on both Windows and 
Macintosh systems (platform independent). To use PDF 
documents, you need Adobe Reader® or Acrobat.® Multi-page 
documents can be saved as one PDF file. When you save color 
or grayscale images in PDF, you can select a compression level. 
You can also edit the scanned images before saving them. See 
Scanning Directly to a PDF File for details.

PICT (*.PCT) 
(Macintosh 
only)

A standard image file format for Macintosh. Most Macintosh 
programs, including word processing programs, can read and 
prepare images in this format.

PRINT Image 
Matching II 
JPEG (*.JPG) 
or TIFF (*.TIF)

A file format that includes PRINT Image Matching® II data for 
enhanced quality and a wider color range. PRINT Image 
Matching II compatible printers can then print using this data for 
brilliant, true-to-life results. (PRINT Image Matching data does 
not affect the way the image displays on a screen.) Available in 
JPEG or TIFF format. 
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■ Show this dialog box before next scan
Select this option if you want the File Save Settings window to appear 
automatically before you scan. If you deselect it, you must click the arrow to 
the right of the Scan button and select File Save Settings to open the 
window.

■ Open image folder after scanning
Select this option if you want Windows Explorer or the Macintosh Finder to 
automatically open to the folder where your scanned image is saved when 
Epson Scan finishes scanning.

5. Click OK. Epson Scan starts scanning.

The scanned image is saved in the file and location you chose.

Selecting Epson Scan Settings

Follow the instructions in these sections to change the Epson Scan mode, if necessary, 
and select scanning settings:

■ Changing the Scan Mode

■ Using Full Auto Mode

■ Selecting Basic Settings

■ Selecting the Scan Resolution

■ Previewing and Adjusting the Scan Area

■ Adjusting the Color and Other Image Settings

■ Selecting the Scan Size

■ Finishing the Scan
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Changing the Scan Mode

To change the scan mode, click the arrow in the Mode box at the top right of the 
Epson Scan window. Then select the mode you want to use from the list that appears.

Note: 

The mode you select remains in effect when you start Epson Scan the next time.

For instructions on scanning using these modes, see:

■ Full Auto Mode: Using Full Auto Mode.

■ Home or Professional Mode: Selecting Basic Settings.
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Using Full Auto Mode

When you start Epson Scan for the first time, it runs in Full Auto Mode and displays 
the Epson Scan standby window:
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Note: 

If you want to change the scan mode, see Changing the Scan Mode.

1. If you want to select a custom resolution or restore faded colors in your image, 
click the Customize button. You see the Customize window:

Select your settings and click OK. (For details on selecting settings, click the Help 
button.)

2. Click the Scan button. 
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3. The File Save Settings window appears. For instructions on selecting options, see 
Selecting File Save Settings.

4. When you are finished selecting File Save Settings, click OK. Epson Scan starts 
scanning in Full Auto Mode. 
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Epson Scan previews your image, detects whether it is a photo or document, and 
selects the scan settings automatically. After a moment, you see a small capture of 
your image in the Epson Scan window.

Note: 

If you need to change any settings, click the Pause button. You return to the 
Epson Scan standby window. If you need to cancel scanning, click the Cancel 
button when it appears.

5. Depending on how you started Epson Scan, the program saves the file to the 
location you specified or opens the scanned image in your scanning program. See 
Finishing the Scan for details.

Selecting Basic Settings

When you start Epson Scan in Home or Professional Mode, you see the main Epson 
Scan window:
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Home Mode
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Professional Mode

Before you scan your document or photo, you need to select these basic settings:

■ Original settings. These tell Epson Scan the type of document or photo you are 
scanning.

■ Destination settings. These tell Epson Scan how you plan to use your scanned 
image so it can select the correct default resolution (scan quality) for you.

Follow these steps to select the basic settings for a document or photo in Epson Scan:

1. Do one of the following to select your document type:

Home mode:
Click the arrow to open the Document Type list and select the type of original 
you are scanning. Then click the Color, Grayscale, or Black & White button to 
select the colors in the original.
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Professional mode:
Click the arrow to open the Document Type list and select Reflective (for 
scanning a document or photo). Then click the arrow in the Auto Exposure Type 
list and select Document or Photo.

2. Do one of the following to select your destination setting(s):

Home mode:
Click the button for the way you plan to use the scanned image in the Destination 
box:

■ Screen/Web for images you will view only on a computer screen or post on 
the web.

■ Printer for images you will be printing or converting to editable text with an 
OCR (Optical Character Recognition) program.

■ Other if you want to select a specific resolution for other purposes.

Professional mode:
Click the arrow to open the Image Type list and select the detailed image type you 
are scanning:

3. Epson Scan selects a default resolution setting based on the original and 
destination settings you select. See Selecting the Scan Resolution to continue 
scanning. 

Image Type 

setting Type of image you are scanning

24-bit Color Color photo

Color Smoothing Color graphics, such as a chart or graph

8-bit Grayscale Black-and-white photo with just a few shades of gray

Black & White Document with black text and/or line art
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Selecting the Scan Resolution

In Home Mode, you can change the resolution only if you select Other as the 
Destination setting.

In Professional Mode, you can select the resolution you want at any time.

Before you select the scan resolution, you should consider whether you will enlarge 
the images, and if so, whether you will enlarge them as you scan or after you scan. 
Follow these guidelines:

■ You will not be enlarging the images.
If you will scan the images at 100% size or smaller and will not enlarge them later, 
you can accept the Resolution setting selected by Epson Scan based on your 
original and destination settings.

■ You will enlarge the images as you scan them (increase the Target Size setting).
If you will enlarge the images in Epson Scan so you can use them at a larger size, 
you can accept the Resolution setting selected by Epson Scan based on your 
original and destination settings.

■ You will scan the images at their original size, but then enlarge them later in an 
image-editing program.
If you plan to enlarge your images later in an image-editing program, you need to 
increase the Resolution setting to retain a high image quality after enlargement. 
Increase the resolution by the same amount you will increase the image size. For 
example, if the resolution is 300 dpi (dots per inch), but you will increase the 
image size by 200% in an image-editing program, change the Resolution setting 
to 600 dpi in Epson Scan.
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Click the arrow next to the Resolution list and select the number of dots per inch at 
which you want to scan. See the table below for some guidelines:

After selecting the Resolution, you can preview your image and make any necessary 
adjustments. See Previewing and Adjusting the Scan Area to continue scanning.

Previewing and Adjusting the Scan Area

Once you have selected your basic settings and resolution in Home or Professional 
Mode, you can preview your image and select or adjust the area of the image(s) you 
want to scan. Epson Scan displays the preview image(s) in a separate Preview window 
on your screen.

There are two types of preview:

■ Normal preview displays your previewed images in their entirety. You must select 
the scan area and make any image quality adjustments manually. Normal is the 
default preview type in Professional Mode, but you can also select it in Home 
Mode, if available.

■ Thumbnail preview displays your previewed images as thumbnails. Epson Scan 
automatically locates the edges of your scan area and applies automatic exposure 
settings to the images. Thumbnail is the default preview type in Home Mode, 
but you can also select it in Professional Mode, if available.

Note: 

Depending on your document type and other settings, Normal preview may be 
automatically selected and you will not be able to change to Thumbnail preview. 

What you will do with the 

scanned image Suggested scan resolution

Send via e-mail, upload to web, view 
only on the screen

96 to 150 dpi

Print, convert to editable text (OCR) 300 dpi

Fax 200 dpi

Enlarge after scanning at 100% Increase Resolution setting by same amount 
you will increase image size after scanning
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Follow these steps to preview your image(s) in Home or Professional Mode:

1. Click the Preview button toward the bottom of the Epson Scan window. If you 
want to check or change the preview type, click the arrow next to the Preview 
button, if it is available.

Epson Scan prescans your image(s) and displays them in one of the following 
Preview windows:

Normal preview
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Thumbnail preview

2. If you are viewing the Thumbnail preview, you can do the following to adjust the 
image(s):

■ To zoom in on an image, double-click its thumbnail, or click the thumbnail 
and then click the Full Size tab near the top of the Preview window. 
(Available only when you’ve scanned multiple images at one time.)

■ To rotate an image or flip it horizontally (like a mirror image), click its 
thumbnail and then click the rotation icon or mirroring icon.

■ To adjust the scan area to crop your image, you can create and move a 
marquee that marks the edges of your scan. See Adjusting the Scan Area 
(Marquee) for instructions.

■ To adjust the image quality, click the image(s) you want to modify and make 
the adjustments as described in Adjusting the Color and Other Image 
Settings. If you want to apply the adjustments you have made to all your 
images, click the All button.

3. If you are viewing the Normal preview, you can do the following to adjust the 
image(s):
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■ To select your scan area, click the auto locate icon to place a marquee that 
marks the edges of your image area. You can move the marquee to change the 
scan area. See Adjusting the Scan Area (Marquee) for instructions.

Note: 

If you are going to scan at a different size than your original, you must first 
select your Target Size and automatically create a marquee that is 
proportioned to that size. See Selecting the Scan Size for instructions. You 
can then copy the marquee and place it on each image you will scan at that 
size.

■ To zoom in on an image, click inside the scan area and click the Zoom 
button. Epson Scan prescans again and displays a larger preview on the Zoom 
tab. (Your other images are still previewed at the original size on the Preview 
tab.)

■ To adjust the image quality, click the image(s) you want to modify and make 
the adjustments as described in Adjusting the Color and Other Image 
Settings. 

4. When you have finished adjusting the scan area, and modifying the color and 
image settings, you can select the size of your scanned image, if you have not 
already selected it. See Selecting the Scan Size for instructions.

Adjusting the Scan Area (Marquee)

A marquee is a moving dotted line that appears on the edges of your preview image to 
indicate the scan area. 

Marquee
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You can move the marquee, adjust its size, and create multiple marquees on one 
image (Normal preview only) to scan different image areas in separate scan files. 
Follow these steps:

1. To draw a marquee, move your cursor over a preview image. The pointer becomes 
a set of cross-hairs. 

2. Position the pointer in the area where you want to place the corner of your 
marquee and click. Hold down the mouse button and drag the cross-hairs over 
the image to the opposite corner of the desired scan area. Then release the mouse 
button. You see the moving dotted line of the marquee.

3. Do one of the following to adjust the marquee:

■ To move the marquee, position your cursor inside the marquee. The pointer 
becomes a hand. Click and drag the marquee to the desired location.
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■ To resize the marquee, position your cursor over the edge or corner of the 
marquee. The pointer becomes a straight or angled double-arrow. Click and 
drag the edge or corner to the desired size.

Note: 

To restrict movement of the marquee to vertical or horizontal only, hold down 
the Shift key as you move the marquee. To restrict sizing of the marquee to 
the current proportions, hold down the Shift key as you resize the marquee.

4. To draw multiple marquees (up to 50; Normal preview only), you can just draw 
them as described in steps 1 through 3, or click the copy marquee icon to 
create additional marquees of the same size. You can move and resize all the 
marquees as described in step 3. To delete a marquee, click inside it and click the 

delete marquee icon.

Adjusting the Color and Other Image Settings

Once you have previewed your images and adjusted the scan area, you can modify the 
image quality, if necessary. Epson Scan offers a variety of settings for improving color, 
sharpness, contrast, and other aspects affecting image quality.

Before you make adjustments, be sure to click the image or marquee for the area you 
want to adjust. In Professional Mode, you also need to scroll down to the 
Adjustments area of the main Epson Scan window:
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The table below describes the settings available in Home and/or Professional Mode. 
For details on adjusting these settings, click Help in the Epson Scan window.

When you are finished making adjustments, you can size your scanned images (see 
Selecting the Scan Size) or go ahead and scan (see Finishing the Scan).

Setting Available mode(s) and description

Color Restoration Full Auto, Home, and Professional:
Restores the colors in faded photos automatically.

Brightness Home and Professional:
Adjusts the overall image lightness and darkness.

In Home Mode, click the Brightness button to access the 
Brightness setting.

In Professional Mode, click the Image Adjustment button to 
access the Brightness setting.

Contrast Home and Professional:
Adjusts the difference between the light and dark areas of the 
overall image.

In Home Mode, click the Brightness button to access the 
Contrast setting.

In Professional Mode, click the Image Adjustment button to 
access the Contrast setting.

Saturation Professional only:
Adjusts the density of colors in the overall image.

Click the Image Adjustment button to access the Saturation 
setting.

Color Balance Professional only:
Adjusts the balance of red, green, and blue colors in the overall 
image.

Click the Image Adjustment button to access the Color 
Balance setting.
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Auto Exposure Home: Automatically applied.

Professional: Click the Auto Exposure button. To turn it on 
continuously, click the Configuration button, click the Color tab, 
and select Continuous auto exposure. You can adjust the level 
of exposure adjustment using the slider.

Unsharp Mask 
Filter

Home: Automatically applied.

Professional: Turn on to make the edges of image areas clearer 
for an overall sharper image. The level of sharpness is 
adjustable. Turn off to leave softer edges.

Descreening Filter Home and Professional:
Removes the rippled pattern that can appear in subtly shaded 
image areas, such as in skin tones. Also improves results when 
scanning magazine or newspaper images which include 
screening in their original print processes. The results of the 
Descreening Filter do not appear in the preview image, only in 
your scanned image.

Histogram Professional only:
Provides a graphical interface for adjusting highlight, shadow, 
and gamma levels individually. For advanced users only.

Click the Histogram Adjustment button to use the Histogram 
settings.

Tone Correction Professional only:
Provides a graphical interface for adjusting tone levels 
individually. For advanced users only.

Click the Tone Correction button to use the Tone Correction 
settings.

Threshold Home and Professional:
Adjusts the level at which the black areas in text and line art are 
delineated, improving text recognition in OCR programs. 
(Available only when you select Black & White as the Image 
Type setting.)

In Home Mode, click the Brightness button to access the 
Threshold setting.
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Note: 

To view the red, green, and blue levels at particular points in your preview image 
as you make adjustments, click the densitometer icon in the preview window 
and click an image area. See Epson Scan help for details.

Certain settings may not be available, or may be automatically selected, 
depending on the type of image you are previewing and other settings you have 
selected.

You can customize how certain Epson Scan settings behave by clicking the 
Configuration button and changing settings in the window that appears. See 
Epson Scan Help for details.

To undo any image quality adjustments you make to the preview image, click the 
Reset button (if available), turn off the setting, or preview your image again.

Selecting the Scan Size

You can scan your images at their original size, or you can reduce or enlarge their size 
as you scan them. You do this using the Target Size setting in Home or Professional 
Mode.

Home Mode

Professional Mode
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If you are going to scan your image to a particular size, such as 8 × 10 inches 
(20,3 × 25,4 cm), you should select the Target Size setting after previewing it, but 
before adjusting your scan area (indicated by the marquee). This sets the scan area to 
the correct proportions so your image will not be cropped unexpectedly. 

For instructions on previewing your image(s), see Previewing and Adjusting the Scan 
Area. Then follow these steps to select the Target Size setting:

1. You can choose a predefined scan size from the Target Size list. Click the arrow in 
the list and select the size you want. A marquee (dotted line) proportioned for that 
size appears on your preview image:

Proportioned 
marquee
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2. If you need to create a scan size that is not in the Target Size list, you can create a 
custom size. Click the arrow in the list and select Customize. You see the Target 
Size window:

Type a name for your custom size, enter the size, click the Save button, then 
click OK. Your new size appears in the Target Size list.

3. In Professional Mode, you can fine-tune the size using additional tools. Click the 
+ (Windows) or (Macintosh) next to Target Size to display these tools:

■ To resize your image by a certain percentage, adjust the Scale value.

■ To change the way your image is cropped, turn Trimming on or off. (See 
Epson Scan Help for details.)

■ To unlock the proportions of your scan size, click the lock icon. Then 
adjust the marquee or enter new width/height measurements.

4. Once you have selected your scan size, you can click and drag the marquee to the 
area in the image you want to scan. For details, see Adjusting the Scan Area 
(Marquee). The marquee proportions are retained as you adjust it.
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If you need to rotate the marquee for a landscape or portrait image, click the 
orientation icon. (Not available if you are scanning at the Original Target 

Size.)

Note: 

For more information about using the Target Size tools, click Help in the 
Epson Scan window.

5. Now you are ready to scan your image(s). See Finishing the Scan for instructions.

Finishing the Scan

When you have finished selecting scan settings, you are ready to scan. Click the Scan 
button. After a few moments, your images are scanned.

What happens after you scan depends on how you started your scan:

■ If you started your scan by running Epson Scan as a standalone program, you 
see the File Save Settings window. This lets you select the name and location 
of your saved scan files. See Selecting File Save Settings for details.

■ If you started your scan from a scanning program such as ArcSoft 
PhotoImpression, your scanned image(s) open in the program window. Click 
Close to close the Epson Scan window and view your image(s) in the 
program.

Restoring Color in Photos

Using the Color Restoration feature in Epson Scan, you can automatically transform 
an old, faded, or badly exposed photo into one with true-to-life color and sharpness as 
you scan.

Follow these steps to restore colors using Epson Scan:

1. Place your original photo on the scanner. See Placing Originals for Scanning for 
instructions.
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2. Start Epson Scan. See Starting Epson Scan for instructions.

3. When the Epson Scan window appears, do one of the following, depending on 
the currently selected scan mode:

■ Home or Professional Mode: go to step 4.

■ Full Auto Mode: click the Customize button, click the Color Restoration 
checkbox, and click OK. Continue with step 9.

Note: 

For details on using Full Auto Mode, see Using Full Auto Mode.

To change the scan mode, see Changing the Scan Mode. 

4. Select the basic settings for the type of original(s) you are scanning, then select the 
destination setting for the way you will use your image(s). See Selecting Basic 
Settings for instructions.

5. Click the Preview button to preview your image(s), then select your scan area. 
See Previewing and Adjusting the Scan Area for instructions.

6. Do one of the following to select the Color Restoration option:

■ Home Mode: Click the Color Restoration checkbox.
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■ Professional Mode: Scroll down to the Adjustments area and click the Color 
Restoration checkbox.

7. Make any other necessary image adjustments. See Adjusting the Color and Other 
Image Settings for instructions.

8. Size your image as necessary. See Selecting the Scan Size for instructions.

9. Click the Scan button to scan and restore the color in your image(s).

What happens next depends on how you started Epson Scan. See Finishing the 
Scan for details.

Scanning Directly to a PDF File

You can scan multiple pages of a document on the document table and save them as 
one PDF file on your computer. Epson Scan displays an editing page so you can view 
the pages as you scan them and reorder, rotate, or delete them as necessary.

1. Place the first page of your original document on the document table. See Placing 
Originals for Scanning for instructions.
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2. Start Epson Scan. See Starting Epson Scan for instructions. You see the Epson 
Scan window:

3. If the Mode box at the top right of the Epson Scan window is set to Full Auto 
Mode, click the Scan button.

If the Mode box is set to Home Mode or Professional Mode, see Selecting 
Basic Settings for instructions.

Note: 

If you want to change the scan mode, see Changing the Scan Mode.
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The File Save Settings window appears:

Select PDF as the file type setting. The current Paper Size, Orientation, Margin, 
and Compression setting are displayed below it.

4. If you need to change any of the current PDF settings, click the Options button. 
You see the Epson PDF Plug-in Settings window:

Select the settings that match your document and click OK. You return to the File 
Save Settings window.
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5. When you are finished selecting file settings, click OK. Epson Scan scans your 
page and displays this window:

6. If you are scanning only one document page, or you don’t need to edit your pages, 
click Done and go to step 9.

If you are scanning multiple pages, click Add page and replace the first page on 
the document table with the second page and click Scan. Repeat this step for 
each page in your document. When you are finished, click Edit page and go to 
step 7.

7. You see the Editing Page window displaying thumbnail images of each scanned 
page:
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If you want to include all the document pages in your PDF file as they currently 
look, go to step 8.

If you want to include only some of the pages, click the odd pages or even 
pages icons, or click the individual pages you want to include.

If you want to rotate or delete pages, click the pages or use the odd pages, 
even pages, or all pages icon to select the pages. Then click the  left or 
right rotate icon to rotate them or the delete icon to delete them.

Note: 

The delete icon is not available when all document pages are selected.

8. When you have finished editing your document pages, click OK. Your document 
is saved in a PDF file in the location you selected and you return to the Epson 
Scan window.

9. Click Close to exit Epson Scan.
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Copying Photos To and From a Memory 
Card

You can copy photo files to and from a memory card inserted in a card slot in your 
Epson Stylus CX4900 Series all-in-one when it is connected to your computer. Make 
sure to follow the guidelines in Memory Card Copying Precautions before you copy 
photo files.

Follow the steps in these sections to copy photo files to and from the card and your 
computer:

■ Copying Photo Files to Your Computer

■ Copying Photo Files to Your Memory Card

When you finish copying files to or from a memory card, see Disconnecting or 
Turning Off Your CX4900 Series for additional instructions.

Memory Card Copying Precautions

Keep the following in mind when copying photos to and from your memory card and 
computer:

■ Check for any handling guidelines in the documentation that came with your 
memory card and adapter.

■ Do not eject your memory card or turn off the CX4900 Series while the memory 
card access light is flashing or you may lose data.

■ Make sure that your memory card is not write-protected. Many memory cards 
have a write-protect switch or seal.

■ Do not copy photos to or from a memory card while you’re printing from the 
memory card.

Copying Photo Files to Your Computer

First install your CX4900 Series software and connect it to your computer as 
described on the Start Here sheet. Then insert your memory card. 

1. Do one of the following:
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Windows XP: Click Start and select My Computer.

Windows 98SE, Me, or 2000: Double-click the My Computer icon on your 
desktop.

Macintosh OS X: Go to step 2.

2. Double-click the removable disk icon, then select the folder in which your photo 
files are saved.

3. Select the photo files you want to copy and drag them to a folder on your 
computer’s hard drive. 

4. When you’re finished, follow the steps in Disconnecting or Turning Off Your 
CX4900 Series before turning off the CX4900 Series.

Copying Photo Files to Your Memory Card

First install your CX4900 Series software and connect it to your computer as 
described on the Start Here sheet. 

Before inserting your memory card, make sure the write-protect switch or seal is set to 
allow writing to the memory card. Then insert your memory card.

Note: 

After copying a photo to a memory card from a Macintosh computer, an older 
digital camera may not be able to read the memory card.

1. Do one of the following:

Windows XP: Click Start and select My Computer.

Windows 98SE, Me, or 2000: Double-click the My Computer icon on your 
desktop.

Macintosh OS X: Go to step 2.

2. Double-click the removable disk icon, then select the folder in which you want to 
save your photo files.

3. Select the folder on your computer’s hard drive that contains the photo files you 
want to copy. Then select the photo files and drag them to the folder on your 
memory card.
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4. When you’re finished, follow the steps in Disconnecting or Turning Off Your 
CX4900 Series before disconnecting or turning off the CX4900 Series.

Disconnecting or Turning Off Your CX4900 Series

When you finish copying files to or from a memory card, follow the steps in this 
section to properly handle the memory card before disconnecting or turning off the 
CX4900 Series.

Windows XP

1. Click the  icon on the task bar.

2. Select Safely remove USB Mass Storage Device.

3. Turn off the CX4900 Series or disconnect the USB cable.

Windows 2000

1. Make sure that the memory card access light and the On light are not flashing.

2. Turn off your computer.

3. Turn off the CX4900 Series or disconnect the USB cable.

Note: 

If you turn off the CX4900 Series or disconnect the USB cable before turning off 
your computer, you see the message “Problem Ejecting USB Mass Storage 
Device.”

Windows Me and 98SE

1. Double-click the My Computer icon on the desktop. 

2. Right-click the Removable Disk icon and click Eject.

3. Turn off the CX4900 Series or disconnect the USB cable.

Macintosh

1. Drag the removable disk icon from your desktop into the trash.
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2. Turn off the CX4900 Series or disconnect the USB cable.
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Maintenance and Transportation

Follow the steps in these sections to keep your Epson Stylus CX4900 Series all-in-one 
in great shape and transport it, if necessary:

Cleaning the Print Head

Replacing an Ink Cartridge

Aligning the Print Head

Cleaning the CX4900 Series

Transporting the CX4900 Series

Cleaning the Print Head

If your printouts are unexpectedly light or faint, or you notice light or dark bands 
across your printout, you may need to clean the print head. This unclogs the nozzles 
so they can deliver ink properly. Print head cleaning uses ink, so clean it only if 
quality declines.

You can clean the print head using the control panel buttons on the CX4900 Series or 
using the Head Cleaning utility on your computer. You can also run a nozzle check to 
see if the print head needs cleaning. 

Note: 

If an ink cartridge is low or expended, you cannot clean the print head. In this 
case, replace the appropriate ink cartridge first.

Caution: 

If you don’t use your CX4900 Series often, it is a good idea to print a few pages at 
least once a month to maintain good print quality.

■ Checking the Print Head Nozzles

■ Running the Head Cleaning Utility

■ Examining the Nozzle Check Pattern

Checking the Print Head Nozzles

1. Make sure the CX4900 Series is turned on but not printing, and the ink cartridges 
are not low or expended.
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2. Windows: Right-click the  printer icon on your taskbar (in the lower right 
corner of your screen). Select Nozzle Check.

Macintosh OS X: Open the Applications folder and select EPSON Printer 
Utility. Select Stylus CX4900 in the printer list, click OK, and select Nozzle 
Check.

You see a screen like the following: 

3. Click Print. The nozzle check pattern prints:

4. If there are no gaps or lines, click Finish.

If there are gaps or lines, or the test patterns are faint, click Clean. Then follow 
the steps in Running the Head Cleaning Utility to clean the nozzles.

Running the Head Cleaning Utility

1. Make sure the CX4900 Series is turned on but not printing, and the ink cartridges 
are not low or expended.

Print head is 
clean:

Print head needs 
to be cleaned:
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2. Windows: Right-click the  printer icon on your taskbar (in the lower right 
corner of your screen). Select Head Cleaning.

Macintosh OS X: Open the Applications folder and select EPSON Printer 
Utility. Select Stylus CX4900 in the printer list, click OK, and select Head 
Cleaning.

You see a screen like the following: 

3. Click Start or Next.

Cleaning takes several seconds. The CX4900 Series runs a head cleaning cycle and 
the On light flashes.

Caution: 

Never turn off the CX4900 Series while head cleaning is in progress. You may 
damage it.

4. When the On light stops flashing, make sure paper is loaded in the CX4900 
Series, then do the following:

Windows: Click Print Nozzle Check Pattern. Then click Print. 

Macintosh: Click Confirmation, then click Next.

The nozzle check pattern prints (see Examining the Nozzle Check Pattern for 
details).

5. If there are no gaps or lines, click Finish.
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If there are still gaps or lines, or the test patterns are faint, click Clean to clean the 
print head again. 

If you don’t see any improvement after cleaning the print head four times, refer to 
Problems and Solutions. You can also turn the printer off and wait at least six 
hours. This lets any dried ink soften. Then try cleaning the print head again.

Tip: 

If you do not use your CX4900 Series often, it is a good idea to print a few pages 
at least once a month to maintain good print quality.

Examining the Nozzle Check Pattern

Examine the nozzle check pattern you printed. Each staggered line should be solid, 
with no gaps, as shown.

■ If there are no gaps or lines, click Finish. 

■ If you see any gaps (as shown below), or the test patterns are faint, click Clean to 
clean the print head again. 

Replacing an Ink Cartridge

Note: 

Do not open ink cartridge packages until you are ready to install the ink. 
Cartridges are vacuum packed to maintain reliability.

■ When the red ink light flashes, one or more ink cartridges are low on ink.

■ When the red ink light stays on, you need to replace the cartridge(s).

You’ll also see a message on your computer screen when you print telling you which 
cartridge is low or expended. (You cannot print when a cartridge is expended.)
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When a cartridge is more than six months old, you may need to replace it if printouts 
don’t look their best. If the quality doesn’t improve after cleaning and aligning the 
print head, you can replace the cartridge even if it is not low.

Note: The ink cartridges that came with your printer have a lower yield due to the 
ink charging process. This process is carried out the first time you turn on your 
printer and guarantees better performance. Don’t load paper before installing the 
ink cartridges.

■ Checking the Ink Supply

■ Purchasing Ink Cartridges

■ Ink Cartridge Precautions

■ Removing and Installing Ink Cartridges

Checking the Ink Supply

To check your ink supply, do the following:

■ Windows: Double-click the icon on your taskbar (in the lower right corner of 
your screen). You see a window like the following:

■ Macintosh OS X: Open the Applications folder and select EPSON Printer 
Utility2. Select Stylus CX4900 in the printer list, click OK, and select EPSON 
StatusMonitor.
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You see a window like this:

Purchasing Ink Cartridges

Use these Epson ink cartridges within six months of installing them and before the 
expiration date on the package.

You can purchase genuine Epson ink and paper from an authorized Epson reseller. To 
find the nearest reseller, please call your nearest Epson sales office as described in 
Where To Get Help.

Color Part number T code number

Black 73 T073120

73 (High Capacity) T073120H (High Capacity)

Cyan 73 T073220

Magenta 73 T073320

Yellow 73 T073420

Click a cartridge image to 
display information about it.
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Ink Cartridge Precautions

Warning: 

Keep ink cartridges out of the reach of children and don’t drink the ink.

Be careful when you handle used ink cartridges; there may be ink remaining 
around the ink supply port. If ink gets on your skin, wash it off with soap and 
water. If it gets in your eyes, flush them immediately with water.

Caution: 

Do not put your hand inside the CX4900 Series or touch any cartridges during 
printing. 

Install a new ink cartridge immediately after removing an expended one. Leaving 
cartridges uninstalled can dehydrate the print head and may prevent the CX4900 
Series from printing.

If you remove an ink cartridge for later use, protect the ink supply area from dirt 
and dust and store it in the same environment as the CX4900 Series. Note that 
there is a valve in the ink supply port, making covers or plugs unnecessary, but 
care is needed to prevent the ink from staining items that the cartridge touches. 
Do not touch the ink cartridge ink supply port or surrounding area.

If you remove a low or expended ink cartridge, you cannot reinstall and use the 
cartridge.

Removing and Installing Ink Cartridges

Be sure you have a new ink cartridge before you begin. Once you start replacing a 
cartridge, you must complete all the steps in one session.

Caution: 

Leave the expended cartridge installed until you have obtained a replacement, or 
the ink remaining in the print head nozzles may dry out. To ensure good results, 
use genuine Epson ink cartridges and do not refill them. Other products may 
cause damage to your CX4900 Series not covered by Epson’s warranty.

1. Make sure the CX4900 Series is turned on.
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2. Make sure that the document cover is closed, then open the scanner.

Caution: 

Do not open the scanner when the document cover is open.

3. Press and release the ink button. The On and ink lights flash. 

Note: 

Do not hold down the ink button for more than 3 seconds or the printer will 
start to clean the print head.

If one of the cartridges is low or expended, the CX4900 Series moves that 
cartridge to the expended ink mark. Go to step 4.

If no cartridges are low or expended, the ink cartridge holder moves to the ink 
replacement position. Go to step 5.

Caution: 

Do not move the print head by hand; this may damage the CX4900 Series. 
Always press the ink button to move it.
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4. Press the ink button again. 

■ If more than one cartridge is low or expended, the next cartridge moves to the 
expended ink mark. 

■ Once the CX4900 Series has identified all of the low or expended ink 
cartridges, the print head moves to the ink cartridge replacement position.

5. Open the cartridge cover.

6. Squeeze the tab at the back of the cartridge and lift it straight out. Dispose of it 
carefully. Do not take the used cartridge apart or try to refill it.
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Warning: 

If ink gets on your hands, wash them thoroughly with soap and water. If ink gets 
into your eyes, flush them immediately with water. 

7. Before you open the new ink cartridge package, shake it four or five times. Then 
remove it from the package.

Caution: 

Do not touch the green chip on the cartridge. This can damage the ink cartridge.

8. Remove the yellow tape from the bottom of the ink cartridge.

Caution: 

If you do not remove the yellow tape before installing the ink cartridge, print 
quality may decline or you may not be able to print.
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Caution: 

Do not remove any other seals from the cartridges.

9. Place the new ink cartridge into the cartridge holder and push it down until it 
clicks into place.

10. Replace any other cartridges that need to be replaced. 

11. Close the ink cartridge cover and press it until it clicks into place. 
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12. Close the scanner.

13. Press the ink button. The CX4900 Series begins charging ink, and the ink 
and On lights start flashing. This takes about one minute. When it’s finished, the 
On light stops flashing and remains on, and the ink light goes out.

Caution: 

Never turn off the CX4900 Series while the On light is flashing or you’ll waste ink.

Note: 

If the ink light stays on (not flashing), the ink cartridge may not be installed 
correctly. Press the ink button again and reinstall the ink cartridge until it clicks 
into place. 

If you replaced a cartridge while copying a document or photo, cancel printing and 
make sure your original is still placed correctly on the document table. Then copy 
your original again.

Aligning the Print Head

If your printouts look grainy or blurry, or you see light or dark horizontal banding, 
you may need to align the print head.

Note: 

Banding may also occur if your cartridges are low on ink or you need to clean the 
print head.

1. Turn on the CX4900 Series.

2. Load several sheets of paper.
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3. Windows: Right-click the  printer icon on your taskbar (in the lower right 
corner of your screen). Select Print Head Alignment.

Macintosh OS X: Open the Applications folder and select EPSON Print 
Utility. Select Stylus CX4900 in the printer list, click OK, and select Print Head 
Alignment.

4. Follow the instructions on the screen to print a vertical alignment sheet. You see a 
window like this one:

5. Look at the five sets of patterns in your printout. For each set, if you see a pattern 
with no visible vertical lines, enter its number in the corresponding box on the 
screen and click Next.

If you can’t find an aligned pattern, choose the one that’s closest to being aligned. 
Click Realignment and then Print to print another alignment sheet and repeat 
this step.
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6. Click Print to print a black horizontal alignment sheet. After it’s printed, you see 
a window like this one:

7. Look at the printout and select the pattern with no gap or line between the 
rectangles. Enter the number for that pattern in the box on the screen and click 
Next.

If you can’t find an aligned pattern, choose the one that looks the best. Then click 
Realignment to print another alignment sheet and repeat this step.
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8. Click Print to print a color horizontal alignment sheet. After it’s printed, you see a 
window like this one:

9. Look at the printout and find the pattern with no gap or line between the 
rectangles and enter its number in the box on the screen.

If you can’t find an aligned pattern, choose the one that looks the best. Then click 
Realignment to print another alignment sheet and repeat this step.

10. Click Finish to close the Print Head Alignment Utility.

Cleaning the CX4900 Series

To keep your CX4900 Series working at its best, you should clean it several times a 
year.

1. Turn off the CX4900 Series, unplug the power cord, and disconnect the USB 
cable.

2. Remove all the paper, then use a soft brush to clean the sheet feeder.

3. If the glass surface of the document table is dirty, clean it with a soft dry cloth, or 
use a small amount of glass cleaner on a soft cloth to clean it. Do not spray glass 
cleaner directly on the glass.
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4. If the outer case or inside of the sheet feeder is dirty, clean it with a soft cloth 
dampened with mild detergent. Keep the scanner section closed to prevent water 
from getting inside.

5. If ink accidentally gets inside the printer, wipe it off with a damp cloth.

Warning: 

Don’t touch the gears or any other parts inside the CX4900 Series.

Caution: 

Never use a hard or abrasive brush, or benzine, alcohol, or paint thinner for 
cleaning; they can damage the CX4900 Series components and case.

Don’t get water on the CX4900 Series components and don’t spray lubricants or 
oils inside the CX4900 Series.

Transporting the CX4900 Series

If you need to ship your CX4900 Series, you must prepare it for transportation by 
packing it in its original box or one of a similar size.

1. Turn off the CX4900 Series. 

2. Remove any paper from the sheet feeder and close the paper support. 

3. Unplug the power cord from the electrical outlet. Then disconnect the USB cable 
from the CX4900 Series.

4. Open the scanner section and make sure the ink cartridge holder is in the home 
position on the right.

Clean here
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5. Secure the ink cartridge holder (print head) to the case with tape.

Caution: 

Be sure to remove the tape after installing the CX4900 Series in its new location 
before you turn it on.

6. Close the scanner section, push in the output tray extension, and close the output 
tray.

7. Repack the CX4900 Series in the original box using the protective materials that 
came with it.

Keep the CX4900 Series level as you transport it. 

After transporting the CX4900 Series, remove the tape securing the print head, plug 
in the CX4900 Series, and turn it on. If you notice a decline in print quality, clean the 
print head; if output is misaligned, align the print head.
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Solving Problems

If your Epson Stylus CX4900 Series all-in-one has any problems, see these sections for 
solutions:

Diagnosing Problems

Problems and Solutions

If you need to uninstall and reinstall your software to solve a problem, see 
Uninstalling Your Software.

If the solutions here don’t solve your problem, see Where To Get Help.

Note: If you need help identifying parts on your CX4900 Series, see CX4900 
Series All-in-One Parts.

Diagnosing Problems

■ Checking the Lights

■ Running a Printer Check

Checking the Lights

If the lights on the CX4900 Series come on or flash, or a number or letter appears in 
the Copy window, check the explanations listed below.

Light: status

Copy 

window 

status Cause Solution

On: Flashing

Error: On

— No paper is loaded 
in the sheet 
feeder.

Load paper in the sheet 
feeder, then press 

Start Color to continue or 
Stop to cancel. See 

Loading Paper for instructions.

— Multiple pages 
have been fed into 
the sheet feeder.

Remove and reload the paper, 
then press Start Color to 
continue or Stop to cancel. 
See Loading Paper for 
instructions.
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Error: Flashing — Paper is jammed. See Paper Feeding Problems 
to remove it.

Ink: Flashing — An ink cartridge is 
running low on 
ink.

See Replacing an Ink Cartridge 
for instructions.

Ink: On — An ink cartridge is 
expended or not 
installed correctly.

Error: Flashing

Memory Card (all 
3 lights):
Flashing

1 An unsupported 
memory card is 
inserted.

Remove the incompatible 
memory card. 

The inserted 
memory card does 
not contain any 
valid images.

See Technical Specifications 
for a list of compatible card 
types and Selecting File Save 
Settings for a list of compatible 
image types.

Light: status

Copy 

window 

status Cause Solution
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Error: Flashing

Print From Index 
Sheet: Flashing

2 An index sheet 
was not 
recognized 
because it is not 
positioned 
correctly.

Position the index sheet 
correctly on the glass, aligning 
the top of it with the left edge 
of the glass. Then press 

Start Color to continue or 
Stop to cancel.

3 The index sheet is 
marked 
incorrectly. 
(No marks are 
detected or the 
sheet includes 
more than one 
mark for an 
image.)

Remove the index sheet, mark 
it correctly, and try again. 

4 The index sheet 
does not match 
the photos on the 
memory card. 

Remove the memory card and 
insert the card used to print 
the index sheet or place the 
correct index sheet on the 
glass. Then press 

Start Color to continue or 
Stop to cancel.

Error: Flashing

Print All/DPOF/
PictBridge: 
Flashing

P An unsupported 
device is 
connected to the 

(USB) port on 
the front.

Disconnect the device.

Error: Flashing 
fast

H The paper 
thickness lever is 
set to the 

H position.

If you have set the lever to the 
H position because you are 

printing envelopes, continue 
printing. Otherwise, set the 
lever to the L position.

Light: status

Copy 

window 

status Cause Solution
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Note: 

When you turn off the CX4900 Series, a red light inside it may stay on for up to 15 
minutes. This is normal.

Running a Printer Check

You can run a printer check to determine whether a problem comes from the CX4900 
Series itself or some other source.

1. Make sure both the CX4900 Series and computer are turned off. Then disconnect 
the USB cable from the CX4900 Series.

2. Make sure letter- or A4-size plain paper is loaded in the CX4900 Series.

3. Press the ink and On buttons together and hold them down for about 
5 seconds. The CX4900 Series turns on and prints a test pattern. It also shows the 
percentage of usable ink left in each cartridge:

4. Turn off the CX4900 Series after it prints the test page. Then reconnect the USB 
cable and turn on your CX4900 Series and computer.

Error: On

Ink: On

All other lights: 
Flashing

E A CX4900 Series 
part needs to be 
replaced.

Contact your local authorized 
servicer or contact Epson for a 
referral; see Where To Get 
Help.

All lights: Flashing E There is a problem 
with the CX4900 
Series.

Turn the CX4900 Series off 
and then back on. If the error 
does not clear, contact your 
local authorized servicer or 
contact Epson for a referral; 
see Where To Get Help.

Light: status

Copy 

window 

status Cause Solution
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■ If the test page prints, the problem probably lies in your software settings, the 
USB cable, or your computer. It’s also possible that your software may not be 
installed correctly. See your Start Here sheet for instructions on reinstalling 
the CX4900 Series software.

■ If the test page doesn’t print, you may have a problem with the CX4900 
Series. Try the suggestions in Problems and Solutions. If nothing works, 
contact Epson as described in Where To Get Help.

Problems and Solutions

■ Setup and Software Installation Problems

■ Printing or Copying Problems

■ Print Quality Problems

■ Scan Quality Problems

■ Paper Feeding Problems

■ Miscellaneous Printout Problems

Setup and Software Installation Problems

Tip: 

It’s a good idea to check Epson’s support website, www.latin.epson.com, 
periodically for free updates to your CX4900 Series printing and scanning 
software. Download instructions are posted for your convenience. You can also 
click the Driver Update button on the Maintenance tab in your Windows printer 
driver screen for printer driver updates. Click the Driver Update shortcut in the 
Epson Scan menu in the Programs folder for scanner driver updates.

The CX4900 Series makes noise after ink cartridge installation.

■ The first time you install ink cartridges, the CX4900 Series must charge its print 
head for a minute or so. Wait until charging finishes (the green On light stops 
flashing) before you turn off the CX4900 Series, or it may charge improperly and 
use excess ink the next time you turn it on. 

If the printer stops moving or making noise, but the green On light is still flashing 
after 5 minutes, turn off the CX4900 Series. If the light is still flashing when you 
turn it back on, contact Epson as described in Where To Get Help.
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■ Turn off the CX4900 Series, then make sure the ink cartridges are inserted 
completely and the ink cartridge cover is closed completely. Also make sure no 
packing material remains in the CX4900 Series. Wait a moment, then turn the 
CX4900 Series back on to clear the error.

You’re having problems installing the CX4900 Series software.

■ Make sure your CX4900 Series is turned on and the USB cable is securely 
connected at both ends. Then carefully follow the installation instructions on the 
Start Here sheet. Also make sure your system meets the requirements listed in 
System Requirements.

■ Close your other programs, including any screen savers and virus protection 
software, and install the software again.

■ In Windows, make sure the CX4900 Series is selected as the default printer and 
that the correct port is shown in the printer properties.

■ If you’re using Windows 2000 and you see an error message or your software 
doesn’t install correctly, you may not have software installation privileges. Contact 
your System Administrator.

■ If you’re using Windows and the USB port, make sure your system was not 
upgraded from Windows 95. The USB Printer Device Driver may not install 
correctly.

■ Make sure the USB Controller is working properly in Device Manager. See your 
Windows help system for details. If it’s not working, contact your computer 
manufacturer.

■ If you’re printing over a network, see Setting Up Network Printing for 
instructions.

Printing or Copying Problems

Only the green On light is on, but nothing prints.

■ Make sure the USB cable is connected securely at both ends and meets the 
requirements listed in System Requirements.

■ Run a printer check. If the test page prints, make sure your software is installed 
correctly. 
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The CX4900 Series sounds as though it is printing, but nothing prints.

■ Make sure the print head nozzles are not clogged. For instructions, see Cleaning 
the Print Head.

■ The CX4900 Series won’t operate properly if it’s tilted or at an angle. Place it on a 
flat, stable surface that extends beyond the base in all directions.

The CX4900 Series makes noise when you turn it on or after it has been sitting 
for awhile.

The CX4900 Series is performing routine maintenance.

You don’t see the printer icon in the lower right corner of your screen 
(taskbar) in Windows.

Try restarting your computer. If you still don’t see the icon, follow these steps:

1. Click Start, point to Settings or Printers and Faxes, then select Printers. 

2. Right-click EPSON Stylus CX4900 Series and select Printing Preferences. 

3. Click the Maintenance tab.

4. Click the Speed and Progress button, then click the Monitoring Preferences 
button.

5. Click the Shortcut Icon box. Then click OK to close the open windows.

Printing is too slow.

Make sure your system meets the requirements listed in System Requirements. If 
you’re printing a high-resolution image, you need more than the minimum 
requirements listed. You may also need to:

■ Clear space on your hard drive or run a defragmentation utility.

■ Close programs that you’re not using.

■ Increase your system’s memory.

For the fastest printing, try these tips:

■ Choose black ink in your printer settings if your document doesn’t include color.

■ For Windows, choose Draft for Quality Type.
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■ For Macintosh, set the Quality/Speed slider to Speed.

■ If the CX4900 Series is connected to a USB hub, disconnect unused USB devices.

Print Quality Problems

You see banding (light lines).

■ The print head nozzles may need cleaning. 

■ Select a higher Quality Option or Print Quality and turn off High Speed mode. 
See Printing in Windows or Printing with Macintosh OS X.

■ Make sure the paper Type or Media Type setting matches the paper you loaded; 
see Selecting the Correct Paper Type for guidelines.

■ Make sure the printable side of the paper is face-up. It’s usually brighter or whiter.

■ The ink cartridges may need replacing.

■ If you have a Macintosh, try using Automatic mode. See Printing with Macintosh 
OS X for instructions.

■ Run the Print Head Alignment utility.

■ If a dotted line appears in the image, clean the scanner glass with a soft, dry, 
lint-free cloth (paper towels are not recommended), or use a small amount of glass 
cleaner on a soft cloth, if necessary. Don’t spray glass cleaner directly on the glass. 
See Cleaning the CX4900 Series for details.
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Your printout is blurry or smeared.

■ Make sure your paper isn’t damp or curled, or loaded face-down (the printable 
side should be face-up).

■ Use a support sheet with special paper, or try loading your paper one sheet at a 
time.

■ Make sure your paper meets the specifications listed in Paper.

■ Use Epson papers to ensure proper saturation and absorption of genuine Epson 
inks.

■ Set the paper thickness lever to the L position for most paper types. If you are 
printing on envelopes, set the lever to the H position. See Loading Paper for 
details.

■ Align the print head.

■ If you are copying, make sure your original is placed flat against the document 
table glass and the CX4900 Series is not tilted or placed on an uneven surface.

■ Remove each sheet from the output tray as it is printed.

■ Avoid handling printouts on glossy paper for a few hours to allow the ink to set.

■ If ink smears on the back of a printout, clean the inside of the printer.

■ If you are using double-sided paper and printing heavily saturated or dark images 
on the front side of the paper, you may notice that smudges or marks appear on 
the front when you print the second side. If one side of the paper will contain a 
lighter image or text, print that side first to eliminate marks or smudging.
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Your printout is faint or has gaps.

■ The print head nozzles may need cleaning. 

■ The ink cartridges may be old or low on ink. See Replacing an Ink Cartridge for 
details. 

■ Make sure the paper Type or Media Type setting matches the paper you loaded. 
See Selecting the Correct Paper Type for guidelines.

■ Make sure your paper isn’t damaged, old, dirty, or loaded face-down. If it is, 
reload a new stack of paper with the printable side up; it is usually brighter or 
whiter than the other side. For best results, use genuine Epson paper.

You see wrong or missing colors.

■ Make sure your printer software is not set to use black ink only.

■ The print head nozzles may need cleaning.

■ The ink cartridges may be old or low on ink. See Replacing an Ink Cartridge for 
details.

■ Try turning off PhotoEnhance.TM 

■ For Macintosh, try using Automatic mode.

■ Try changing the Gamma setting; see Customizing Windows Print Settings, 
Customizing Mac OS X Print Settings.

■ Your printed colors can never exactly match your on-screen colors. However, you 
can use a color management system to get as close as possible. Try using the ICM 
(Windows) or ColorSync (Macintosh) setting. 

■ For best results, use genuine Epson ink and paper.



106

Your printout is grainy.

■ Make sure the printable side of the paper is face-up. It’s usually brighter or whiter.

■ Try using a higher quality paper or select a higher Quality Option or Print 
Quality setting. See Printing in Windows or Printing with Macintosh OS X.

■ Select Photo RPM for Quality Type (Windows) or Print Quality (Macintosh). 
Remember that this setting increases print time.

■ Run the Print Head Alignment utility.

■ You may need to increase the image resolution or print it in a smaller size; see 
your software documentation.

Scan Quality Problems

You see only a few dots in your scanned image.

■ Make sure the document is placed on the document table with the side to be 
scanned facing down. See Placing Originals for Scanning for details.

■ When scanning with the Black&White setting in Home or Professional Mode, 
change the Threshold setting. See Adjusting the Color and Other Image Settings 
for instructions.

A line of dots always appears in your scanned images.

If a dotted line appears in the image, clean the scanner glass with a soft, dry, lint-free 
cloth (paper towels are not recommended), or use a small amount of glass cleaner on a 
soft cloth, if necessary. Don’t spray glass cleaner directly on the glass. See Cleaning the 
CX4900 Series for details.

Straight lines in your image come out crooked.

Make sure the document lies perfectly straight on the document table.

Your image is distorted or blurred.

■ Make sure the document lies flat on the document table. Also make sure your 
document is not wrinkled or warped.

■ Make sure you do not move the document or the CX4900 Series while scanning.
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■ Make sure the CX4900 Series is placed on a flat, stable surface.

■ Select Unsharp Mask Filter in Epson Scan’s Professional Mode window. See 
Adjusting the Color and Other Image Settings for instructions.

■ Adjust the Auto Exposure setting in Epson Scan’s Professional Mode window. 
See Adjusting the Color and Other Image Settings for instructions.

You can also select Color Control and Continuous auto exposure in the 
Configuration window, or select the Color tab and click the Recommended 
Value button to return the Auto Exposure setting to the default. See Epson Scan 
Help for details.

■ Increase the Resolution setting. See Selecting the Scan Resolution for instructions.

Colors are patchy or distorted at the edges of your image.

If your document is very thick or warped at the edges, cover the edges with paper to 
block external light as you scan.

Your scanned image is too dark.

■ Change the Display Gamma setting to match your output device, such as a 
monitor or printer, in the Epson Scan Configuration window. See Epson Scan 
Help for details.

■ Adjust the Auto Exposure setting in Epson Scan’s Professional Mode window. 
See Adjusting the Color and Other Image Settings for instructions.

You can also select Color Control and Continuous auto exposure in the 
Configuration window, or select the Color tab and click the Recommended 
Value button to return the Auto Exposure setting to the default. See Epson 
Scan Help for details.

■ Check the Brightness setting in Epson Scan’s Home or Professional Mode (see 
Adjusting the Color and Other Image Settings). Or adjust brightness using the 
Histogram in Professional Mode (see Epson Scan Help).

■ Check the brightness and contrast settings of your computer monitor.
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An image on the back of your original appears in your scanned image.

If your original is printed on thin paper, images on the back may be visible to the 
CX4900 Series and appear in your scanned image. Try scanning the original with a 
piece of black paper placed on the back of it. Also make sure the Document Type and 
Image Type settings are correct for your original. See Selecting Basic Settings for 
details.

Rippled (moiré ) patterns appear in your scanned image.

A moiré is a rippled pattern that may appear in a scanned image of a printed 
document. It is caused by interference from the differing pitches in the scanner’s 
screen and the halftone screen in your original.

■ Select the Descreening Filter check box in Epson Scan’s Home or Professional 
Mode window. In Professional Mode, set the Screen Ruling of the Descreening 
Filter setting to an appropriate setting for your document and deselect the 
Unsharp Mask Filter setting. See Adjusting the Color and Other Image Settings 
for instructions.

■ Select a lower Resolution setting. See Selecting the Scan Resolution for 
instructions.

Characters are not recognized well when converted into editable text (OCR).

■ Make sure the document lies perfectly straight on the document table. 

■ In Home Mode, select Black&White as the Image Type setting. In Professional 
Mode, select None for the B&W Option setting. Then try adjusting the 
Threshold setting.

■ Check your OCR software manual to see if there are any settings you can adjust in 
your OCR software.

Scanned colors differ from the original colors.

■ Change the Image Type setting in Epson Scan’s Home or Professional Mode. See 
Selecting Basic Settings for instructions. Select different combinations of this 
setting and the others mentioned below.

■ Change the Display Gamma setting to match your output device, such as a 
monitor or printer, in the Epson Scan Configuration window. See Epson Scan 
Help for details.
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■ Adjust the Auto Exposure setting in Epson Scan’s Professional Mode. Also try 
selecting a different Tone Correction setting. See Adjusting the Color and Other 
Image Settings for instructions. 

■ Try selecting the following settings in the Configuration window: Color Control, 
Continuous auto exposure, and Recommended Value (on the Color tab). 
Also try turning off the Fast Preview setting. See Epson Scan Help for details.

■ Check the color matching and color management capabilities of your computer, 
display adapter, and software. Some computers can change the palette of colors on 
your screen. See your software and hardware manuals for details.

■ Use the color management system for your computer: ICM for Windows or 
ColorSync for Macintosh. With Windows, add a color profile that matches your 
monitor to improve on-screen color matching. (Exact color matching is very 
difficult. Check your software and monitor documentation for information on 
color matching and calibration.)

■ Printed colors can never exactly match the colors on your monitor because 
printers and monitors use different color systems: monitors use RGB (red, green, 
and blue) and printers typically use CMYK (cyan, magenta, yellow, and black).

You have trouble adjusting the scan area in the thumbnail preview.

■ Create a marquee or adjust the existing marquee to select the area you want to 
scan. See Adjusting the Scan Area (Marquee) for instructions.

■ In the Configuration window, adjust the thumbnail cropping area using the 
Thumbnail Cropping Area slide. See Epson Scan Help for details.

■ Switch to the Normal preview type (if available) and preview your image again. 
See Previewing and Adjusting the Scan Area for instructions.

Paper Feeding Problems

Paper doesn’t eject fully or is wrinkled.

■ If the paper doesn’t eject fully, you may have set the wrong paper size. Press the 
Start button to eject the paper, and then select the correct paper size.

■ If it’s wrinkled when it ejects, the paper may be damp or too thin. See the Paper 
specifications.
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Paper doesn’t feed correctly or jams in the printer.

■ If paper doesn’t feed, remove it from the sheet feeder. Reload it against the right 
edge, behind the tabs, then slide the left edge guide against the paper. Make sure 
the paper is not in front of the feeder guard.

■ If multiple pages feed at once, remove the paper from the sheet feeder, fan the 
edges to separate the sheets, then reload it.

■ Don’t load too many sheets at once (up to 20 sheets of photo paper or 100 sheets 
of plain paper). See Special Papers for details.

■ Heavily saturated prints may curl, causing a paper jam when printing on both 
sides of the paper.

■ If paper is jammed, the red Error light flashes.

Follow these steps to clear the jam:

1. Press the Start button to eject the jammed paper. If the jammed paper is not 
ejected, go to the next step.

2. If the paper is stuck near the sheet feeder or output tray, gently pull it out and 
press the Start button to clear the error condition.

If the paper is stuck inside the CX4900 Series, press the On button to turn it 
off. Open the scanner and remove any paper inside, including any torn pieces. Do 
not pull it backward however; this can damage the sheet feeder. Close the scanner, 
then turn the CX4900 Series back on.

If your paper loads incorrectly or jams frequently:

■ Use new, smooth, high-quality paper, loaded printable side up.

■ Fan the edges of the stack of paper to separate the sheets.

■ Don’t load paper above the arrow mark inside the left edge guide.

■ Place the paper against the right edge behind the tab. Slide the left edge guide 
against it, but not too tightly.

■ If you’re printing on both sides of the paper, try loading fewer sheets.
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Miscellaneous Printout Problems

The image is inverted, as if viewed in a mirror.

■ Turn off the mirror setting in your application program. 

■ For Windows, turn off Mirror Image in the Page Layout window of your printer 
driver.

■ For Macintosh, turn off Flip Horizontal in the Print Settings window.

The CX4900 Series prints blank pages.

■ If you’re using Windows, make sure the CX4900 Series is selected. For Macintosh 
OS X, make sure your printer is selected in the Page Setup and Print windows.

■ The print head nozzles may need cleaning; see Cleaning the Print Head for 
instructions. 

The margins are incorrect.

■ Make sure the paper settings are correct for your paper size. For instructions, see 
Printing in Windows or Printing with Macintosh OS X.

■ Make sure the paper you loaded matches the paper size and paper type settings 
you selected on the CX4900 Series control panel or in your printer software.

■ Choose the correct margins for your paper size.

■ If you’re using Mac OS X, make sure you choose the same printer in the Page 
Setup window and the Print window.

■ Use the Print Preview option in your printer software to check your margins 
before you print.

■ Make sure your paper is positioned next to the right side of the feeder.

Output is not what you expect when printing borderless photos.

■ Make sure you are printing on paper that support borderless printing. See 
Loading Paper for Borderless Photos for details.

■ Use the expansion setting to adjust how the image fits on the page. See Printing 
Borderless Photos.
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■ Don’t choose a custom paper size setting when printing borderless photos.

Too many copies are printing.

Make sure that the Copies option in your printer software or program is not set for 
multiple copies.

You see incorrect characters.

■ Make sure the USB cable is securely connected and meets the requirements listed 
in System Requirements. Then try printing again.

■ Make sure your printer is selected in Windows, or is set as the active printer in 
Print Center (Mac OS X). 

■ If you’re using a switch box or USB hub with your printer, connect the printer 
directly to your computer.

The image size/position is incorrect.

Make sure the paper and layout options are set correctly.

There are scratches on your print.

If you’re printing on glossy paper, prints may be scratched if not handled properly. 
Don’t place objects on top of your prints, and be careful not to scratch them with 
your fingernails. For best results, frame your prints under glass.

Uninstalling Your Software

■ Windows

■ Macintosh OS X

Windows

1. Turn off the CX4900 Series.

2. Disconnect the USB cable from the CX4900 Series.

3. Click Start, and select Programs or All Programs.
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4. Point to Epson or Epson Printers, then select Epson Printer Software 
Uninstall.

5. In the next window, select EPSON Stylus CX4900 Series, and click OK. Then 
follow the on-screen instructions.

6. Open the Windows Control Panel and double-click the Add or Remove 
Programs icon (Windows XP) or the Add/Remove Programs icon 
(Windows 98SE, Me, or 2000).

7. Click EPSON Scan in the list of currently installed programs and click 
Change/Remove (Windows XP or 2000) or Add/Remove (Windows 98SE or 
Me).

8. When the confirmation window appears, click Yes.

9. Follow the on-screen instructions to uninstall Epson Scan.

In some cases, a message may appear to prompt you to restart the computer. If so, 
make sure Yes, I want to restart my computer now is selected and click 
Finish.

10. Restart your computer, then see the Start Here sheet to reinstall your software.

Macintosh OS X

1. Open the Applications folder, then the Utilities folder.

2. Open Print Center or Printer Setup Utility, select your CX4900 Series, then 
click the Delete button.

3. Insert the CX4900 Series software CD-ROM in your CD-ROM or DVD drive.

4. Double-click the Epson CD-ROM icon on your desktop.

5. Open the Common > EPSON Scan folder.

6. Double-click the EPSON Scan Installer icon.

7. When the Installer window appears, select Uninstall from the pop-up menu at 
the top and click the Uninstall button.

8. Open the English > OSX folder.

9. Double-click the Installer icon.
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10. When the Installer window appears, select Uninstall from the pop-up menu at 
the top and click the Uninstall button.

11. Restart your Macintosh, then see the Start Here sheet to reinstall your software.
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CX4900 Series All-in-One Parts

Paper support 
extension

Feeder guard

Left edge 
guide

USB port

Paper support

Memory 
card cover 

USB external 
device 
connector

Document 
cover

Document 
table

Memory card slots Output tray and 
extension

AC inlet

Control panel 
(buttons and lights)

Paper thickness lever

Ink cartridges

Scanner
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Where To Get Help

Internet support service in Latin America 

Telephone support service in Latin America

Note: 

If your country does not appear on the list, contact the nearest Epson sales office. 
Toll or long distance charges may apply. 

Please have the following information ready:

■ Product name (Epson Stylus CX4900 Series)

■ Product serial number (located on the back of the printer)

■ Proof of purchase (such as a store receipt) and date of purchase

■ Computer configuration and operating system version

Service Access

World Wide Web From the Internet, you can reach Epson Support 
at www.latin.epson.com. At this site, you can 
download drivers and other files, access 
troubleshooting information, and receive 
technical advice through e-mail.

Country Telephone number

Argentina (54-11) 5167-0300

Brazil (55-11) 4196-6350

Chile (56-2) 230-9500

Colombia (57-1)523-5000

Costa Rica (506) 210-9555
(1-800) 377-6627

Mexico
Mexico City
Other cities

(52-55) 1323-2052
1-800-087-1080

Peru (51-1) 418-0210

Venezuela (58-212) 240-1111
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■ Description of the problem

You can purchase genuine Epson ink and paper from an authorized Epson reseller. To 
find the nearest reseller, please call your nearest Epson sales office.

Setting Up Network Printing

These sections tell you how to set up the CX4900 Series so that other computers on a 
network can print to it.

Note: 

This section is for small network users only. If you are on a large network and 
would like to share the CX4900 Series, consult your network administrator.

■ Windows XP, XP Professional x64 Edition, and 2000

■ Windows Me and 98SE

■ Macintosh OS X

Windows XP, XP Professional x64 Edition, and 2000

Note: 

To install software programs in Windows 2000, it is necessary to log on as a user 
with administrative privileges (a user who belongs to the Administrators group).

To install software programs in Windows XP, it is necessary to log on with a 
Computer Administrator account. You cannot install software programs if you log 
on as a Limited account user. After you install Windows XP, the user account is 
set as a Computer Administrator account.

The images that are provided in the following section pertain to Windows XP.

First, you need to set up the CX4900 Series as a shared printer on the computer that it 
is directly connected to. Then, you must install the CX4900 Series on each computer 
that will access it through the network.
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Setting Up a Shared Printer

Follow the steps below to configure your computer to share the CX4900 Series with 
other computers on a network.

1. Click Start > Control Panel or Start > Settings > Control Panel, then click 
Printers and Other Hardware or Printers and Faxes.

2. Windows XP: You may need to click View installed printers or fax printers.

3. Right-click the EPSON Stylus CX4900 Series icon, then click Sharing.

4. Select Shared as or Share this printer, then type a name for the shared printer.

Note: 

Do not use spaces or hyphens in the shared printer name.

Note: 

With Windows XP, you may need to run the Network Setup Wizard before you 
can set up printer sharing. Start the wizard and follow the on-screen instructions 
until you see the screen above.

5. If you want Windows XP or 2000 to automatically download printer drivers to 
computers that are running different versions of Windows, click Additional 
Drivers and select the environment and the operating systems for the other 
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computers. Click OK, then insert the printer software CD into the CD-ROM 
drive. Select the folder for Windows XP or 2000. Click OK to install the 
additional drivers.

6. Click OK, or click Close if you installed additional drivers.

Accessing a Network Printer

Follow the steps below to print to the CX4900 Series from other computers on a 
network.

Note: 

The CX4900 Series must be set up as a shared resource on the computer to 
which it is directly connected before you can access it from another computer. 
For instructions, see Setting Up a Shared Printer.

1. Click Start > Control Panel or Start > Settings > Control Panel, then click 
Printers and Other Hardware or Printers and Faxes.

2. Select Add a printer or double-click the Add Printer icon. The Add Printer 
Wizard opens.

3. Click Next. 

4. Select A network printer, or printer attached to another computer and click 
Next.
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5. On the next screen, click Next.

6. Double-click the icon of the computer that is directly connected to the CX4900 
Series. Then click the EPSON Stylus CX4900 Series icon.

7. Click Next and follow the on-screen instructions.

Note: 

Depending on the operating system and the configuration of the computer to 
which the CX4900 Series is connected, the Add Printer Wizard may prompt you 
to install the printer driver from the CX4900 Series software CD. In this case, click 
the Have Disk button and follow the on-screen instructions.

Windows Me and 98SE

This section tells you how to set up the CX4900 Series so that other computers on the 
network can print to it.

Note: 

This section is for small network users only. If you are on a large network and 
would like to share the CX4900 Series, consult your network administrator.

First, you need to set up the CX4900 Series as a shared printer on the computer that it 
is directly connected to. Then you must install the CX4900 Series on each computer 
that will access it through the network.
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Setting Up a Shared Printer

Follow the steps below to configure your computer for printer sharing and to share 
the CX4900 Series with other computers on a network.

1. Click Start > Settings > Control Panel.

2. Double-click the Network icon.

3. Click the File and Print Sharing button.

4. Select the I want to be able to allow others to print to my printer(s) check 
box and click OK.

5. In the Network dialog box, click OK.

Note: 

If a dialog box requesting the insertion of the Windows 98SE or Me CD-ROM 
appears, insert the CD into the CD-ROM drive and follow the on-screen 
instructions.

If a dialog box requesting that you restart your computer appears, do so. Then 
continue with step 6.

6. In the Control Panel, double-click the Printers icon.

7. Right-click the EPSON Stylus CX4900 Series icon, then click Share As.
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8. Type a name for the shared printer, then click OK.

Accessing a Networked Printer

Follow the steps below to print to the CX4900 Series from other computers on a 
network.

Note: 

The CX4900 Series must be set up as a shared resource on the computer to 
which it is directly connected before you can access it from another computer. 
For instructions, see Setting Up a Shared Printer.

1. Click Start > Settings > Printers.

2. Double-click the Add Printer icon. The Add Printer Wizard opens.

3. Click Next.
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4. Select Network printer, then click Next.

5. On the next screen, click Browse.

6. Double-click the icon of the computer that the CX4900 Series is directly 
connected to. Then click the EPSON Stylus CX4900 Series icon.

7. Click OK and follow the on-screen instructions.

Macintosh OS X 

To share the CX4900 Series with other computers on a network, follow the steps 
below to configure the computer that it is directly connected to.
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Setting Up a Shared Printer

To share the CX4900 Series with other Mac OS X computers on a network, follow 
the steps below to configure the computer that it is directly connected to.

1. Turn on the CX4900 Series.

2. Select System Preferences from the Apple® menu or the dock, then select the 
Sharing icon.

3. Click the checkbox next to Printer Sharing and close System Preferences. 

Accessing a Networked Printer

Follow the steps in this section to access the CX4900 Series from other Macintosh OS 
X computers on the network.

1. Turn on the CX4900 Series.

2. Print as you normally would, choosing the CX4900 Series from the Shared 
Printers list that appears in the Page Setup and Print menus.
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Specifications

For details about your Epson Stylus CX4900 Series all-in-one and using it with your 
computer, see these sections:

System Requirements

Technical Specifications

System Requirements

To use your CX4900 Series and its software, your system should meet the 
requirements below.

Windows System Requirements

■ A Microsoft® Windows compatible PC with a Pentium®-equivalent processor 
(300 MHz or faster recommended)

■ Microsoft Windows 98SE, Windows 2000, Windows Me, Windows XP, or 
Windows XP Professional x64 Edition

■ At least 256MB RAM (512MB recommended)

■ 200MB free hard disk space (300MB recommended)

■ VGA monitor with at least a 256 color display

■ CD-ROM or DVD drive for installing the printer software

■ A computer with preinstalled Windows 98SE, 2000, Me, XP, or Windows XP 
Professional x64 Edition, and a Windows-compliant USB port and shielded USB 
“AB” cable up to 2 meters (6.5 feet) long. Using an improperly shielded USB 
cable may cause the CX4900 Series to malfunction. 

Macintosh System Requirements

■ An Apple iMac™ series; Power Macintosh® G3, G4, or G5; PowerBook®, 
iBook™, Mac mini, or eMac™; or iMac, MacBook Pro, or Mac mini with Intel® 
Core™ Duo or Solo

■ Macintosh OS X 10.2.8 to 10.4.x
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■ 512MB RAM

■ 200MB free hard disk space (300MB recommended)

■ VGA monitor with at least a 256 color display

■ CD-ROM or DVD drive for installing the printer software

■ A shielded USB “AB” cable up to 2 meters (6.5 feet) long. Using an improperly 
shielded USB cable may cause the printer to malfunction.

Technical Specifications

■ Printing

■ Scanning

■ Paper

■ Printable Area

■ Memory Card Slots

■ Ink Cartridges

■ Mechanical

■ Electrical

■ Environmental

■ Standards and Approvals

■ USB Interface
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Printing

Scanning

Paper

Note: 

Since the quality of any particular brand or type of paper may be changed by the 
manufacturer at any time, Epson cannot guarantee the quality of any non-Epson 
brand or type of paper. Always test a sample of paper stock before purchasing 
large quantities or printing large jobs.

Printing method On-demand ink jet

Nozzle configuration Black: 90 nozzles

Color: 270 nozzles (90 each cartridge: cyan, magenta, 
yellow)

Print direction Bidirectional with logic seeking

Scanner type Flatbed color

Photoelectric device CIS

Effective pixels 10,200 × 14,040 pixels at 1200 dpi

Document size 216 × 297 mm (8.5 × 11.7 inches) A4 or US letter size

Scanning resolution 1200 dpi (main scan)
2400 dpi with Micro Step DriveTM (sub scan)

Output resolution 50 to 4800, 7200, and 9600 dpi
(50 to 4800 dpi in 1 dpi increments)

Scanning speed B/W: Approximately 10 msec per line at 1200 dpi
Color: Approximately 30 msec per line at 1200 dpi

Image data 16 bits per pixel per color internal
8 bits per pixel per color external (maximum)

Interface One USB 2.0 Hi-Speed or USB 1.1 port

Light source RGB three color LED
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Single sheets

Envelopes

Note: 

Poor quality paper may reduce the print quality and cause paper jams or other 
problems. If you have print quality problems, switch to a higher grade paper.

Do not load curled or folded paper.

Use paper only under these conditions:
Temperature: 15 to 25 °C (59 to 77 °F)
Humidity: 40 to 60% RH

Size A4 (21,1 cm × 29,7 cm; 8,3 × 11,7 inches)

A5 (14,7 × 21,1 cm; 5,8 × 8,3 inches)

A6 (10,4 × 14,7 cm; 4,1 × 5,8 inches)

Letter (8,5 × 11 inches; 21,6 × 27,9 cm)

Legal (8,5 × 14 inches; 21,6 × 35,6 cm)

Half-letter (5,5 × 8,5 inches; 14 × 21,6 cm)

4 × 6 inches (10,2 × 15,2 cm)

5 × 7 inches (12,7 × 17,8 cm)

3,5 × 5 inches (8,9 × 12,7 cm)

8 × 10 inches (20,3 × 25,4 cm)

User Defined up to 21,6 × 111,8 cm (8,5 × 44 inches)

Paper type Plain bond paper or special paper distributed by Epson

Thickness 0,08 to 0,13 mm (0,003 to 0,005 inch)

Weight (for plain bond 
paper)

64 to 90 g/m² (17 to 24 lb)

Size No. 10 (4,1 × 9,5 inches; 10,4 × 24,1 cm)

Paper type Plain bond paper

Weight 75 g/m² (20 lb) to 90 g/m² (24 lb)
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Printable Area

Single sheets or cards

Envelopes

Note: 

Always load paper into the sheet feeder with the short edge first. Load envelopes 
flap edge left with the flap side down.

A: The minimum top margin is 3.0 mm (0.12”).

B-L: The minimum left margin is 3.0 mm (0.12”); 5.0 mm (0.20”) for envelopes

B-R: The minimum right margin is 3.0 mm (0.12”); 5.0 mm (0.20”) for envelopes.

C: The minimum bottom margin is 3.0 mm (0.12”).

D The minimum bottom margin is 20 mm (0.78”) for envelopes.

* When printing with the borderless feature, print quality may decline in the 
expanded area. Before printing large jobs using the borderless setting, print a 
single sheet to confirm printout quality.

A

C

B-L B-R

Normal Borderless*
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Memory Card Slots

* Adapter required

Compatible memory cards CompactFlash 

Memory Stick

Memory Stick PRO

Memory Stick Duo*

Memory Stick PRO Duo*

MagicGate Memory Stick

MagicGate Memory Stick Duo*

Microdrive

SD (Secure Digital)

SDHC

miniSD*

miniSDHC*

microSD*

microSDHC*

MultiMediaCard

xD-Picture Card

xD-Picture Card Type M

xD-Picture Card Type H

Voltage Requirements 3.3 V

Maximum current is 500 mA



131

Memory Card Slot Compatibility

Ink Cartridges

* Ink thaws and is usable after approximately 3 hours at 25 °C (77 °F).

Caution: 

To ensure good results, use genuine Epson ink cartridges and do not refill them. 
Other products may cause damage to your printer not covered by Epson’s 
warranty.

Do not use an ink cartridge if the date on the package has expired.

CF Type II card slot Compatible with CF+ and CompactFlash Specification 
3.0 cards

Memory 
Stick/MemoryStick PRO 
card slot

Compatible with Memory Stick Standard version 1.42-00 
or Memory Stick Standard Memory Stick PRO Format 
Specifications version 1.02-00 cards

SD/MMC card slot Compatible with SD Memory Card Specifications / 
PART1. Physical Layer Specification Version 2.00 cards 
and MultiMediaCard Standard Version 4.1 cards

xD-Picture card Slot Compatible with xD-Picture card Card Specification 
Version 1.20 cards

Color Cyan, magenta, yellow, black

Cartridge life 6 months at 25 °C (77 °F) after opening the package

Temperature Storage: 

–20 to 40 °C (–4 to 104 °F)

1 month at 40 °C (104 °F)

Freezing*: –16 °C (3.2 °F)
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Mechanical

Electrical

Environmental

Paper path Sheet feeder, top entry

Sheet feeder capacity About 100 sheets at 64 g/m² (17 lb)

Dimensions Width: 430 mm (16.9 inches)

Depth: 354 mm (13.9 inches)

Height: 181 mm (7.1 inches)

Weight 6.5 kg (14.3 lb) without the ink cartridges

100-120 V Model 220-240 V Model

Input voltage 90 to 132 V 198-264 V

Rated frequency 50 to 60 Hz 50 to 60 Hz

Rated current 0.4 A (0.7 A max) 0.2 A (0.4 A max)

Power 
consumption

Approx. 13 W (operating)

Approx. 4 W in low-power 
mode

Approx. 3.5 W in sleep mode

Approx. 0.2 W in power-off 
mode

Approx. 13 W (operating)

Approx. 4 W in low-power 
mode

Approx. 3.5 W in sleep mode

Approx. 0.3 Win power-off 
mode

Temperature Operation: 10 to 35 °C (50 to 95 °F)

Storage: –20 to 40 °C (–4 to 104 °F)

Humidity
(without condensation)

Operation: 20 to 80% RH

Storage: 5 to 85% RH
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Standards and Approvals

USB Interface

Safety UL 60950-1

CSA C22.2 No. 60950-1

EMC FCC part 15 Subpart B class B

CAN/CSA-CEI/IEC CISPR 22 Class B

Standard Based on Universal Serial Bus Specifications Revision 2.0

Bit rate 480 Mbps (High speed device)

Adaptable connector USB Series B

Recommended cable 
length

Under 2 meters (6.5 feet)
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Appendix

■ Important Safety Instructions

■ Copyright Notice

■ Trademarks

Important Safety Instructions

Before using your Epson Stylus CX4900 Series all-in-one, read and follow these safety 
instructions:

■ Be sure to follow all warnings and instructions marked on the CX4900 Series.

■ Use only the type of power source indicated on the CX4900 Series label.

■ Use only the power cord that comes with the CX4900 Series. Use of another cord 
may cause fires or shock. Do not use the cord with any other equipment.

■ Place the CX4900 Series near a wall outlet where the plug can be easily 
unplugged.

■ Do not let the power cord become damaged or frayed.

■ If you use an extension cord with the CX4900 Series, make sure the total ampere 
rating of the devices plugged into the extension cord does not exceed the cord’s 
ampere rating. Also, make sure the total ampere rating of all devices plugged into 
the wall outlet does not exceed the wall outlet’s ampere rating.

■ Avoid locations that are subject to rapid changes in heat or humidity, shocks or 
vibrations, or dust.

■ Leave enough room around the CX4900 Series for sufficient ventilation. Do not 
block or cover openings in the CX4900 Series case or insert objects through the 
slots.

■ Do not place the CX4900 Series near a radiator or heating vent or in direct 
sunlight.

■ Place the CX4900 Series on a flat, stable surface that extends beyond its base in all 
directions. It will not operate properly if it is tilted or at an angle. 

■ Make sure the back of the CX4900 Series is at least 10 cm (4 inches) away from 
the wall.
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■ Do not open the scanner section while the CX4900 Series is copying, printing, or 
scanning.

■ Do not spill liquid on the CX4900 Series.

■ Except as specifically explained in your documentation, do not attempt to service 
the CX4900 Series yourself.

■ Unplug the CX4900 Series and refer servicing to qualified service personnel under 
the following conditions: if the power cord or plug is damaged; if liquid has 
entered the product; if the product has been dropped or the case damaged; if the 
product does not operate normally or exhibits a distinct change in performance. 
Adjust only those controls that are covered by the operating instructions.

■ When storing or transporting the CX4900 Series, do not tilt it, stand it on its 
side, or turn it upside down; otherwise ink may leak from the cartridge.

■ Please consult your state and local regulations regarding disposal or recycling of 
your CX4900 Series. Do not put in the trash.

Ink Cartridge Safety Instructions

■ Keep ink cartridges out of the reach of children and do not drink the ink.

■ Do not open ink cartridge packages until you are ready to install the ink. 
Cartridges are vacuum packed to maintain reliability.

■ Install a new ink cartridge immediately after removing an expended one. Leaving 
cartridges uninstalled can dehydrate the print head and may prevent the CX4900 
Series from printing. 

■ If you remove an ink cartridge for later use, protect the ink supply area from dirt 
and dust and store it in the same environment as the CX4900 Series. Note that 
there is a valve in the ink supply port, making covers or plugs unnecessary, but 
care is needed to prevent the ink from staining items that the cartridge touches. 
Do not touch the ink cartridge ink supply port or surrounding area.

■ Be careful when you handle used ink cartridges; there may be ink remaining 
around the ink supply port. If ink gets on your skin, wash it off with soap and 
water. If it gets in your eyes, flush them immediately with water.

■ Do not put your hand inside the CX4900 Series or touch any cartridges during 
printing.
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Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval 
system, or transmitted in any form or by any means, electronic, mechanical, 
photocopying, recording, or otherwise, without the prior written permission of Seiko 
Epson Corporation. The information contained herein is designed only for use with 
this Epson printer. Epson is not responsible for any use of this information as applied 
to other printers.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of 
this product or third parties for damages, losses, costs, or expenses incurred by 
purchaser or third parties as a result of: accident, misuse, or abuse of this product or 
unauthorized modifications, repairs, or alterations to this product, or (excluding the 
U.S.) failure to strictly comply with Seiko Epson Corporation’s operating and 
maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from 
the use of any options or any consumable products other than those designated as 
Original Epson Products or Epson Approved Products by Seiko Epson Corporation.

A Note Concerning Responsible Use of Copyrighted 
Materials

Epson encourages each user to be responsible and respectful of the copyright laws 
when using any Epson product. While some countries’ laws permit limited copying or 
reuse of copyrighted material in certain circumstances, those circumstances may not 
be as broad as some people assume. Contact your legal advisor for any questions 
regarding copyright law.

Trademarks

Epson, Epson Stylus, and PRINT Image Matching are registered trademarks, and 
Exceed Your Vision and Epson Web-To-Page are trademarks of Seiko Epson 
Corporation.
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DURABrite, BorderFree, and RPM are registered trademarks; PhotoEnhance, Micro 
Step Drive, and Easy Photo Fix are trademarks; and Epson PhotoCenter and Epson 
CreativeZone are service marks of Epson America, Inc.

DPOF is a trademark of CANON INC., Eastman Kodak Company, Fuji Photo Film 
Co., Ltd. and Matsushita Electric Industrial Co., Ltd.

SD is a trademark.

SDHC is a trademark

Memory Stick is a registered trademark, and Memory Stick Duo, Memory Stick 
PRO, Memory Stick PRO Duo, MagicGate, MagicGate Memory Stick, and MGMS 
Duo are trademarks of Sony Corporation.

xD-Picture Card is a trademark of Fuji Photo Film Co., Ltd.

General Notice: Other product names used herein are for identification purposes only 
and may be trademarks of their respective owners. Epson disclaims any and all rights 
in those marks.

© 2006 Epson America, Inc. 

6/06



138



1


	Table of Contents
	Epson Stylus CX4900 Series All-in-One User’s Guide
	About Your CX4900 Series
	About Your Software

	Printing From Your Computer
	Loading Paper
	Printing in Windows
	Printing with Macintosh OS X
	Selecting the Correct Paper Type
	Printing Borderless Photos

	Scanning
	Placing Originals for Scanning
	Starting Epson Scan
	Selecting Epson Scan Settings
	Restoring Color in Photos
	Scanning Directly to a PDF File

	Copying Photos To and From a Memory Card
	Memory Card Copying Precautions
	Copying Photo Files to Your Computer
	Copying Photo Files to Your Memory Card
	Disconnecting or Turning Off Your CX4900 Series

	Maintenance and Transportation
	Cleaning the Print Head
	Replacing an Ink Cartridge
	Aligning the Print Head
	Cleaning the CX4900 Series
	Transporting the CX4900 Series

	Solving Problems
	Diagnosing Problems
	Problems and Solutions
	Uninstalling Your Software
	CX4900 Series All-in-One Parts

	Where To Get Help
	Setting Up Network Printing
	Windows XP, XP Professional x64 Edition, and 2000
	Windows Me and 98SE
	Macintosh OS X

	Specifications
	System Requirements
	Technical Specifications

	Appendix
	Important Safety Instructions
	Copyright Notice
	Trademarks



<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.0000
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 300
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 300
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /Description <<
    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000500044004600206587686353ef901a8fc7684c976262535370673a548c002000700072006f006f00660065007200208fdb884c9ad88d2891cf62535370300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef653ef5728684c9762537088686a5f548c002000700072006f006f00660065007200204e0a73725f979ad854c18cea7684521753706548679c300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>
    /DAN <>
    /DEU <>
    /ESP <>
    /FRA <>
    /ITA <>
    /JPN <>
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020b370c2a4d06cd0d10020d504b9b0d1300020bc0f0020ad50c815ae30c5d0c11c0020ace0d488c9c8b85c0020c778c1c4d560002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken voor kwaliteitsafdrukken op desktopprinters en proofers. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)
    /NOR <>
    /PTB <>
    /SUO <>
    /SVE <>
    /ENU (Use these settings to create Adobe PDF documents for quality printing on desktop printers and proofers.  Created PDF documents can be opened with Acrobat and Adobe Reader 5.0 and later.)
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /ConvertColors /NoConversion
      /DestinationProfileName ()
      /DestinationProfileSelector /NA
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /MediumResolution
      >>
      /FormElements false
      /GenerateStructure true
      /IncludeBookmarks false
      /IncludeHyperlinks false
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles true
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /NA
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /LeaveUntagged
      /UseDocumentBleed false
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


